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Gratulation! 

 
Sie haben einen der vielseitigsten, präzisesten und preiswertesten Leistungs-/Energie Logger erworben, 

den ELITEpro XC™. Die Eigenschaften des ELITEpro XC Loggers bieten vielfältige Messmöglichkeiten, 

Echtzeitdatenauswertung und auch ferngesteuerte Datenabfrage. 

 

Zusätzlich beschreibt das Handbuch Eigenschaften und Funktionalität der nutzerfreundlichen und intuitiven 

Software ELOG™. 

 

 

Danke für ihren Einkauf! 
 

 

Produktbeschreibung 
 
Der ELITEpro XC ist ein leistungsstarkes und vielseitiges Messgerät für die Messung elektrischer Leistung 

und Energie. Es ist in der Lage, Spannung, Strom, Schein-, Wirk-, Blindleistung und -energie sowie den 

Leistungsfaktor einer einzelnen Last oder eines ganzen Gebäudes zu messen, zu speichern und zu 

analysieren. Analoge Eingänge ermöglichen Leistungs-/Energieverbrauchsmessungen in Korrelation mit 

weiteren physikalischen Größen wie Temperatur, Druck, Durchfluss usw. z.B. in HVAC-Anlagen. Der 

ELITEpro XC verfügt zusätzlich über einige Möglichkeiten zur Beurteilung der Netzqualität, es können in 

Echtzeit die Wellenformen von Strom, Spannung und Leistung betrachtet werden und das Spektrum der 
Oberwellen bis zur 63. Oberwelle wird berechnet. 

 

Die Stromversorgung des ELITEpro XC erfolgt vom Messobjekt, so dass keine externe Spannungsquelle oder 

voluminöse Batterien notwendig sind. Die Messergebnisse werden auf dem internen nichtflüchtigen 

Speicher aufgezeichnet. Das Zeitintervall ist vom Nutzer wählbar. Der ELITEpro XC ist dank seiner 

Magnethalterung leicht zu montieren und kann durch seine geringe Größe sicher in der Verteilung 

untergebracht werden.  

 

Die Windows-basierte ELOG Software dient dem Parameter-Setup, der Messwertanzeige sowie der 

Übertragung und Analyse der aufgezeichneten Messdaten. ELOG stellt die Messergebnisse graphisch dar, 
bietet Analysefunktionen und automatische ferngesteuerte Datenaufzeichnung sowie auch einen Export 

der Daten in Standardsoftware. 

 

Der ELITEpro XC erfordert einen Computer und ELOG ™-Software für Setup, den Datenabruf und der 

Datenanalyse. Downloaden und testen Sie die Software vor der Installation des Loggers. 
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NEUE FUNKTIONEN 
 

Was ist neu im ELITEpro XC und der ELOG ™-Software?  

Eine Reihe von neuen Features, einige Standard, einige optional, wurden hinzugefügt. 

 

 

• Vier Analogeingänge für Prozesssignale (0…10V, 0/4…20mA) die innerhalb derELOG Software 

konfiguriert werden können und einen Zeitbezug zur Leistungserfassung herstellen können. 
Typische Verwendungen ist die Protokollierung von Umgebungs-Temperatur, Geräte-/Baugruppen-

Temperaturen, solare Sonnenbestrahlung, Tankfüllstände, Druck, usw.. 

 

• Schnellerkennung von Fehlern durch neue PhaseChek LEDs.  

Die LED-Farbe wechselt auf blau, wenn die CTs rückwärtigen Strom erkennen (-kW). Sie blinkt rot, 

wenn die CT auf der falschen Phase anliegt. Wenn beide Probleme vorhanden sind, dann blinkt sie 

abwechselnd blau und rot. 

 

• Die Kanal-Beschreibungen, die in der Setup-Tabelle definiert werden, werden nun auch in den 

Headern der Datendatei in den Spalten übernommen und angezeigt 

 

• Das Softwarefeld „About the Connected Logger…“ wurde hinzugefügt. Es dient der Informationen 

über die Seriennummer des Loggers, dessen Firmware-Versionsnummer, Ethernet-IP-Adresse, 

optionale WLAN-Adresse, etc. 

 

• Erweiterung des nicht flüchtigen Speichers auf 16MB, für bis zu mehreren Monaten Aufnahmezeit. 
 

• Das speichern der Daten beim Export in eine .csv-Datei kann in einem beliebigen Ordner erfolgen 

 

• Beim Importieren einer .csv-Datei haben Sie jetzt die Möglichkeit zur Umbenennung der 

ursprünglichen .elog oder .dat-Datei. 

 

• Die flexiblen Stromzangen (RōCoils) können jetzt von ~ 5A und bis zu 5.000A verwendet werden! 

 

• Standard-Grafik-Export-Typ ist jetzt .jpg (nicht .emf) 

 

• Beim Import/Export einer .elog Datei in eine .csv-Datei werden alle Header-Namen aus der Tabelle 

"SetUp" beibehalten. 
 

• ELOG (ab Vers. 13) ist kompatibel mit Windows 8. 

 

• Datei-Zusammenfassung der Lastspitzen von kW, kVA, kVAR über definierte Zeitabschnitte 

 

• Auto-Poll: mehrere Logger können sortiert nach Seriennummer aufgelistet werden. 
 

• Auto-Poll kann gestartet werden ohne vorherige Öffnung einer Logger-Liste 

 

Und weitere Verbesserungen. Ziel ist die Verbesserung der Software und des Loggers um die 

Benutzerfreundlichkeit zu erhöhen und Probleme verringern. Nutzen Sie diese neuen Features! 
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ELITEPRO XC™ SICHERHEITSANWEISUNGEN 

 

Diese allgemeine Sicherheitsinformation muss sowohl 

vom Anwender als auch vom Servicepersonal des Loggers 

beachtet werden. DENT Instruments, Inc. übernimmt 

keine Haftung für falsches Verhalten bezüglich dieser 

Sicherheitsrichtlinien. 

 
 

 
4RH8 

E186827 

Conforms to UL Std 61010-1 

Certified to CSA Std C22.2 No. 61010-1 

Der ELITEpro XC™ ist ein Gerät der Überspannungskategorie III. Nutzen Sie zugelassene Gummihandschuhe mit 

mechanischem Schutz und Schutzbrille, wenn Sie mit diesem Gerät arbeiten. 

 

Achtung: Dieser Logger kann lebensgefährliche Spannungen führen. 

QUALIFIZIERTES PERSONAL MUSS alle Hochspannungsverbindungen 

trennen, bevor der Logger benutzt oder gewartet wird.  

 

Warnung: Nicht sachgemäßer Gebrauch des Gerätes kann die Wirkung seiner Schutzeinrichtungen 

beeinträchtigen. 

SYMBOLE und deren Bedeutung 

 
Bedeutet Vorsicht. Benutzen Sie das Handbuch zur Beschreibung der Bedeutungen. 

 

Wenn der ELITEpro XC an eine Wechselspannung angeschlossen werden soll, ist folgende Reihenfolge 

zur Vermeidung der Gefahr eines elektrischen Schlags einzuhalten: 

1. Der zu messende Stromkreis muss entladen werden. 

2. Stromzangen an die zu messenden Kabel anbringen. 

3. Gerät mittels Spannungsmessleitungen mit den einzelnen Phasen verbinden. Benutzen Sie die 

für die zu messenden Spannungen erforderliche Sicherheitsausrüstung (Handschuhe und 

Schutzkleidung). 

 

Gefahr eines elektrischen Schlages, lebensgefährliche Spannungen können vorhanden sein. Nur für  

qualifiziertes Personal. 

 

Keine Überschreitung der Spannung von 600V Phase - Phase. Dieser Logger ist für die Messung von 

Spannungen bis 600V Phase-Phase ausgelegt. Die Überschreitung dieser Spannung verursacht Schäden 

am Logger und bringt Gefahr für den Anwender. Höhere Spannungen können nur mit entsprechenden 

Spannungswandlern gemessen werden. Der ELITEpro XC ist nach Überspannungskategorie III 600V 

spezifiziert. 

 
Entsorgung entsprechend den geltenden Vorschriften. 

 
IN: 6-10 VDC, 500 mA 

OUT: 6 VDC, 200 mA Maximum 

 USB Anschluss 
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Einschränkungen bei den zu verwendenden Stromzangen 

 

Es dürfen nur Stromzangen mit Abschlusswiderstand (Spannungsausgang) verwendet 

werden, die max. Ausgangsspannung der Zange darf 333 mV nicht überschreiten. Es 

besteht die Gefahr eines starken elektrischen Schlags und Beschädigung des Loggers, 

wenn Zangen mit Stromausgang verwendet werden. Die folgenden DENT 

Instruments Stromzangen sind UL Anerkannt (UL Underwriters Laboratories ist ein 

unabhängiges Zertifizierungsinstitut) und sind nach 

IEC 61010-1 zertifiziert:  

 

CT-HSC-020-X (20A Mini), CT-HSC-050-X (50A Mini), CT-HMC-0100-X (100A Midi), und 

die CT-HMC-0200-X (200A Midi). Der Gebrauch anderer Stromzangen macht das UL 
Listing des ELITEpro XC ungültig. 
 

 

Der Logger ist nicht für das Messen energiereicher Impulse geeignet. Das Messen an 

Quellen, die energiereiche Impulse liefern, können zu Schäden am Logger führen und für den 

Anwender gefährlich sein. Die Verdrahtung muss den Ansprüchen aus 600V AC CAT III 

genügen. 

 
Das Gerät ist vollständig durch doppelte Isolation geschützt. (IEC 536 Class II). CAT III 80-600 

VAC 125mA 50/60 Hz 

 

Wartung 

 
Eine Wartung des ELITEpro XC ist nicht erforderlich.   
 

Reinigung: Zur Reinigung des ELITEpro XC keine Hilfsmittel, auch kein Wasser benutzen. 

Batterielebensdauer: Die Lithiumbatterie dient nur als Stützbatterie bei Netzausfall zur 

Datensicherung und hat eine Haltbarkeitsdauer von mehr als 10 Jahren.  

Für den Service ist DENT Instruments Inc. zuständig. 

 

Die Nutzung von Zubehör, das nicht in DENT Instruments Produktbeschreibungen und Preislisten 

spezifiziert ist, ist nicht zulässig. 

Falls der Logger beschädigt oder defekt erscheint, zunächst alle Verbindungen trennen und den Service 

oder den Vertriebspartner kontaktieren. 

DENT Instruments Vertriebspartner für Deutschland: 

Bend, Oregon USA PK elektronik Poppe GmbH 

Phone: 541.388.4774 Ameisenweg 6  |  16727 Velten 

DENTinstruments.com Tel. +49 (0) 3304 3909 0 

Email: techhelp@DENTinstruments.com E-Mail:   vertrieb@pk-elektronik.de 
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ELITEPRO XC™ TECHNISCHE SPEZIFIKATIONEN 
 
 

Spezifikation Beschreibung 

Speicher 16 MB nichtflüchtig 

Anschlussarten 
Einphasig 2-Draht, Einphasig 3-Draht, Dreiphasig 4-Draht (Stern), Dreiphasig 3-

Draht (Dreieck) 

Spannungskanäle 3 Kanäle CAT III 0-600V AC (Phase-Phase) oder 600V DC 

Stromkanäle 4 Kanäle, Stromzangen mit Spannungs-Ausgang (0-333 mV AC)  

Max. Eingangsspannung der 

Stromkanäle 
0-666 mV AC oder +/- 1.0V DC 

Messverfahren True RMS, mit high-speed digital signal processing (DSP) 

Netzfrequenz DC/50/60Hz 

Abtastrate 12 kHz 

Kanalabtastrate 

(Interne Abtastung) 

200 samples/Periode bei 60Hz 

240 samples/Periode bei 50Hz 

Messgrößen 
Volt, A, Ah, kW, kWh, kVAR, kVARh, kVA, kVAh, Verschiebungsfaktor (dPF).  

Alle Parameter für jede Phase oder als Gesamtwert 

Genauigkeit Besser als 1% (<0.5% typisch) für V, A, kW, kVAR, kVA, PF  

Auflösung 0.01 A, 0.1 Volt, 0.1 Watt, 0.1 VAR, 0.1 VA, 0.01 Leistungsfaktor 

Mess-Intervall 1, 3, 15, 30 Sekunden; 1, 2, 5, 10, 15, 20 und 30 Minuten; 1 und 12 Stunden; 1 Tag.  

Analoge Messeingänge 
0–10 Volt, 0 oder 4–20 mA Stromschleife nicht isoliert, externe Schleifenversorgung. 

Skalierbare physikalische Einheiten 

LED Anzeiger 

Dreifarbig (rot, grün, blau): 1 LED Anzeige Kommunikation, 4 LEDs für richtigen 

Anschluss der Phasen (grün wenn Strom und Spannung auf der gleichen Phase; rot 

wenn nicht, blau für wireless, Bluetooth wireless technology, und Ethernet),  

  

Datenübertragung 

USB (Standard) USB standard. 1.8 m A-to-B USB Kabel (im Lieferumfang) 

ETHERNET (Standard) 
Standard RJ-45 Anschluss für 10/100 MB Ethernet Cat 5 oder besser. Konfigurierbar 

für DHCP oder statische IP Adresse 

BLUETOOTH® WIRELESS 

TECHNOLOGY (Optional) 

Interne Antenne: typische Reichweite <2,5m bis 25m. Erfordert einen Bluetooth 

wireless technology adapter am PC. Dieser muss Serial Port Profile (SPP) 

unterstützen. 

WiFi ADAPTER (Optional) 

Interner WiFi adapter in zwei Ausführungen: 

• Interne Antenne: typische Reichweite <20m bis 75m 

• Externe 3 dBi Antenne : typische Reichweite <40m bis 75m 

Stromversorgung 

Netzversorgung 

zwischen L1-L2: 80-600VAC CAT III 50/60Hz Phase-Phase. 125mA max. 

Stromaufnahme 

Interne 500mA Sicherung, vom Anwender nicht ersetzbar 

Power In (optional) 6-10 VDC maximum, 500 mA minimum 

Power out 6 VDC, 200 mA max. 
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Mechanische Eigenschaften 

Arbeitstemperaturbereich -7°C bis +60°C  

rel. Luftfeuchtigkeit 5% bis 95%, nicht kondensierend 

Gehäuse ABS Kunststoff, 94-V0 flammability rating 

Gewicht 340 g (ohne Zangen und Messleitungen) 

Abmessungen 69 x 58 x 203 mm  

Minimale Systemanforderungen 

Betriebssystem Windows® 7/8 (32 oder 64 bit), Vista (32 oder 64 bit) oder XP 

Prozessor Pentium Class 1 GHz oder besser empfohlen 

Festplatte 50 MB Minimum frei verfügbar 

Schnittstelle 1x USB 

CD Laufwerk CD oder DVD Laufwerk für Software-Installation 
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SCHNELLSTART-ANLEITUNG 

ELITEpro XC Anschlüsse 
 

 

 

 

  
 

ELITEpro XC  Layout 
 

 
 

 

 

ELITEpro XC  Strom- und Spannungsanschlüsse 
 

 

Wichtig: Schließen Sie den Logger ELITEpro XC erst an ihren Computer an, 
wenn die Software ELOG™ installiert ist! 

Netzversorgung 

In/Out 

Steckverbinder für 

Analogeingänge

Logging On/Comm LED 

USB- Anschluss PhaseChek™ LEDs 

Magnethalterung 

Anschluss 

Stromzangen 

Spannungsbuchsen 

Ethernet LAN Verbindung 
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Diese Anleitung wird empfohlen für Personen, die über Erfahrungen mit DENT Instruments oder 

Leistungsmessgeräten und –prozeduren verfügen.  

Zur Vorbereitung für jeden Einsatz des ELITEpro XC müssen folgende Schritte ausgeführt werden: 

1. Anschließen einer oder mehrerer Stromzangen, außer wenn nur Spannung gemessen werden soll. 

2. Herstellung der Netzverbindung sowohl an die Messeingänge als auch zur Stromversorgung des 

ELITEpro XC. 

3. Erstellung des Setups für die Durchführung der Messung und übertragen desselben an den 

ELITEpro XC. 

 

Der folgende Abschnitt gibt ein Beispiel für das Setup einer einphasigen Leistungsmessung mit dem 
ELITEpro XC und der ELOG Software.  

 

 

 

 

 

 

 

INSTALLATION von ELOG™ SOFTWARE UND USB Treiber 

1. Installieren Sie die ELOG Software auf ihrem Computer. 

a) Nach Einlegen der CD sollte die Installation automatisch erfolgen. Wenn nicht, im Explorer die 

CD aufrufen und ELOGInstaller.exe ausführen.  Gleichzeitig wird die Software Autopoll 

installiert (s. Anhang D). 

b) Führen Sie die Installationsanweisungen aus. 

2. Installieren Sie den ELITEpro XC Treiber auf ihrem Computer.  
a) Verbinden Sie mittels USB-Kabel den Logger mit dem 

Computer (USB Symbol: ). Wenn das Kabel in einer 

Verteilung genutzt werden soll, ist ein Mindestabstand von 

5 cm zu stromführenden Leitungen einzuhalten. 

b) Führen Sie die Installationsanweisungen aus. Sie müssen 

die Treiberinstallation erlauben, um eine korrekte 

Arbeitsweise des Loggers sicherzustellen. 

c) Falls die Treiberinstallation nicht funktioniert, lesen Sie bitte den Abschnitt Fehlersuche bei 
Treiberinstallation. 

 

 

Beachte: Falls ihr PC 

über mehrere USB-

Schnittstellen verfügt, 

muss der Treiber an 

jeder Schnittstelle, die 

genutzt werden soll, 

installiert werden. 

Beachte: Zur Vervollständigung des Schnellstarts brauchen Sie den 

ELITEpro XC nicht mit einer tatsächlichen Last zu verbinden. Sie 

können ein „Schein-Setup“ ausführen, um zu sehen, wie Gerät und 

Software zusammenarbeiten. 
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SETUP ELITEpro XC 

1. Verbinden Sie die Stromzangen mit den Anschlüssen ihres Messobjekts. Drehen Sie die Stromzange so, 
dass der Pfeil auf dem Gehäuse der Zange in Richtung der Last des Verbrauchers zeigt. 
 

2. Stellen Sie die Anschlüsse (L1, L2, und N) her. In diesem Beispiel wird L3 nicht genutzt. 
 

3. Schließen Sie die Stromzangen an den ELITEpro XC an. 

Die Kabelenden der Stromzangen in die (Lüster-)klemmen einschrauben.  

Achtung: Phase L1 (CH1) ist links außen, im Gegensatz zu den Spannungsanschlüssen!  

• Polarität der Zangenanschlüsse beachten, abhängig vom Zangentyp den weißen 

(gestreiften, nummerierten) Draht an (+), den braunen (schwarzen) Draht  an (-) 

• Bei Nutzung von Rogowski-Spulen (flexible Wandler), Abschirmung zur Verminderung 

von Übersprechen und Verbesserung der Genauigkeit mit anschließen. 

  

 

 

 

4. Anschließen der Spannungsmessleitungen L1, L2, und N . 

 

 

Manchmal entsteht beim Anschluss der Spannungsleitungen L1, L2 ein kleiner Funke. 
Dies ist normal und ruft keinen Schaden am Logger hervor. 

 

5.Doppel-Klick auf das ELOG Icon auf dem Windows® Desktop. (ELOG Software ist kompatibel mit 

Windows 7/8 (32 und 64 bit), Vista (32 und 64 bit), und XP, nicht mit älteren Windows-Versionen. 
 
 

6. Verbinden Sie PC und ELITEpro XC mit dem USB-Kabel. 

 
Beachte: Der Anschluss sollte automatisch hergestellt 

werden, falls nicht, im Port drop down menu den 

richtigen Port wählen. Genauere Informationen zu  
“ Friendly Ports” stehen im Abschnitt 1 : 

Kommunikation mit dem ELITEpro XC. 
 

Abschirmung von DENT 

Rogowski-Spulen 

Negativ 
Positiv 

Schirm 

Hinweis: “Friendly Ports” erlaubt 

Ihnen genau festzustellen, wo der 

ELITEpro XC mit dem PC verbunden 

ist, wenn gleichzeitig Verbindung zu 

anderen Geräten besteht. 
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7. Setup ELITEpro XC für einphasige Last 

In diesem Schritt wird ein Setup erstellt, welches dem ELITEpro XC mitteilt, was wie oft usw. zu messen ist. 

a) Klick auf das ELOG File menu und wähle New > Setup Table File > OK. 

b) Falls nicht im Setup Table Type Fenster angezeigt, klick auf Pfeil  , dann klick ELITEpro XC, 

und OK. 

c) Im Quick Setup, klick auf Single Phase 2 Wire Button . Auswahl von Zangentyp und 
Zangenwerten. Klick OK.  

d) Stelle Data Intervall auf 1 Minute (oder anders wie gewünscht). 

e) Netzfrequenz einstellen auf 50Hz (oder 60Hz). 

f) (Optional) Eingabe “Quick Start Setup” im Setup Table Name. 

g) Falls andere Stromzangen als die voreingestellten 100A- Zangen verwendet werden, müssen 

die entsprechenden maximalen Werte für den Eingangsstrom der Zange(dort aufgedruckt) im 

CT selection window /Auswahlfenster (CT=Current Transformer=Stromzange ) eingegeben 

werden.  

h) Eingabe der Phasenverschiebung (falls bekannt und abweichend vom Voreinstellwert 1.1°) der 

gewählten Stromzange. 

i) (Optional) Klick in Kasten neben (Channel 1) Name und schreibe z. Bsp.: “230V Last”. 

j) Klick auf den Pfeil rechts vom Feld Volts und klick auf Average/Durchschnitt (oder auf 

andere Parameter, die aufgezeichnet werden sollen). Wiederhole die Auswahl für Amps, kW, 
kVA , PF (Leistungsfaktor) und kVAR . Sie können alle Kombinationen von Werten für Average, 

Minimum, Maximum und integrale Größen, z.B. Energie (kWh)aufzeichnen. 

k) Klick auf File > Save As… um das Setup auf der Festplatte zu speichern, Namen eingeben, z.B. 

„Sample“ und dann klick Save. 

 

8. Übertragen des Setups an den ELITEpro XC. 

a) Nach erfolgreicher Speicherung des Setups, klick auf  Button.  

b) Wähle Overwrite ACTIVE Table. (Überschreiben des aktiven Setups). ELOG initialisiert 

automatisch die Aufzeichnung mit dem Laden eines neuen Setups.  

c) Wähle Continue Logging (Aufzeichnung fortsetzen). Zur Ansicht der Echtzeit-Messwerte wähle 

Logger > Display Present Readings > Show As Text. 

 

9. Messdaten übertragen und anschauen. 

a) Lassen Sie den Logger einige Zeit aufzeichnen, so dass in Abhängigkeit vom eingestellten 

Messintervall einige Werte aufgezeichnet werden. 

b) Bei immer noch mit dem Logger verbundenem PC, klick auf Logger > Retrieve Data From 
Logger… (Übertrage Daten vom Logger) 

i. Name für die Datei vergeben und Ordner auswählen oder Voreinstellungen nutzen.  

ii. Klick Save. Die Daten werden vom Logger übertragen und nach Abschluss automatisch 

angezeigt. 

c) Wähle Data > Data File Summary zur Anzeige einer Textzusammenfassung. Wähle Data > 
Create New Graph… zur graphischen Darstellung der Messergebnisse. 
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ELOG QUICK SETUP- Zusammenfassung 

In den folgenden Grafiken werden die Einstellungen des beschriebenen Beispiels sowie der Anschlussplan 

für den ELITEpro XC zusammenfassend dargestellt. L2 ist erforderlich für die Stromversorgung des Loggers. 

 

Beispiel Konfiguration des Setup wie folgt: 

 

einphasig, 2-Draht Setup Tabelle in ELOG  

 
 

HINWEIS:  Der Anschluss N auf L2 (hier rot) dient zur Spannungsversorgung des Loggers 

Beachte: Der ELITEpro XC wird nicht von einer internen Batterie versorgt. Stattdessen erfolgt die 

Stromversorgung auf folgende Weise: 

1. Netzversorgung: Der Logger wird automatisch mit Strom versorgt, wenn L1 und L2 

angeschlossen sind, so dass die Stromversorgung während der Messung gesichert ist.  

2.  Versorgung über die USB-Schnittstelle, wenn der Logger per USB-Kabel mit dem PC  
verbunden ist.  

3. Steckernetzteil: Die Stromversorgung über ein Steckernetzteil ist ebenfalls möglich, wenn 

z.B. nur Ströme aufgezeichnet werden sollen, siehe auch Spezifikationen 

Weitere Informationen zu diesem Thema auch auf der Web-Seite von DENT Instruments  
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ABSCHNITT 1: INSTALLATION, SETUP UND GEBRAUCH DES 
ELITEPRO XC™ 

Einführung 

Der ELITEpro XC™ erfordert einen PC und die ELOG™ Software für Setup, Datenübertragung und –

analyse. Die Installation kann vor dem ersten Feldeinsatz vervollständigt und getestet werden.  

 

 

 
Vorsicht: Der ELITEpro XC DARF NUR VON QUALIFIZIERTEN PERSONEN 

ANGESCHLOSSEN WERDEN. ES SIND GEFÄHRLICHE SPANNUNGEN VORHANDEN.  

  

 

 

WARNUNG! 
VOR DER MONTAGE DES LOGGERS ALLE ELEKTRISCHEN VERBINDUNGEN TRENNEN! 

  

Installation der ELOG™ Software auf dem PC 

Dieser Schritt sollte vor dem ersten Anschließen des Loggers vollständig ausgeführt werden. 

Beachte: Der Pfad für Dateien in ELOG ist: 

C:\ Users\UserName\Documents\DENT\ELOG\Data 

ELOG ist kompatibel mit Windows® 7/8 (32 oder 64 bit), Vista (32 oder 64 bit) oder XP. 

1. ELOG CD in ein CD/DVD Laufwerk einlegen. 

 

Die Installation beginnt automatisch, falls nicht, im Explorer die CD aufrufen und 

ELOGInstaller.exe mit Doppelklick starten. 

 

2. Die Anweisungen auf dem Bildschirm ausführen. 

 

Beachte: Mit der Installation von ELOG wird auch das Programm AutoPoll installiert. AutoPoll 
kann für automatische, nicht von einem Bediener ausgelöste Datenübertragungen von einem 

ferngesteuerten Logger genutzt werden. Siehe Anhang E – Automatischer Aufruf eines 

Loggers. 

 

 

3. Installation des ELITEpro XC Treibers auf dem PC.  

Siehe Beschreibung Schnellstartanleitung ab Seite 10 
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Montage des ELITEpro XC 

Der ELITEpro XC darf nur in einer den gültigen technischen Richtlinien entsprechenden Umgebung, 

z.B. geschlossenen Schaltschranken und Verteilungen installiert werden. Sicherheitsvorschriften sind 

zu beachten. 

1. Der ELITEpro XC kann mit Hilfe der Magnethalterung und mittels Schraube befestigt werden. 

Zum Verschrauben dient die schwarze Lasche an der Stirnseite des Gehäuses. Zur Sicherheit 

sollte der Logger in der Nähe eines Ausschalters des zu messenden Stromkreises angebracht 

werden.  

Beachte: Auf ausreichend Platz für alle Anschlüsse ist zu achten. Die Montagelasche ist 

zur Befestigung bei Messungen über weniger als 6 Monate gedacht. Der Logger und die 
Verdrahtung müssen monatlich durch qualifiziertes Personal auf festen Sitz kontrolliert 

werden. 

Zur Demontage des Loggers Schraube lösen und Magnete wie abgebildet abziehen.  

Beachte: Nur für Kurzzeitmessungen darf der Logger mit den rückseitigen Magneten 

auf unlackierten Metallflächen angebracht werden. Die Magnete können eine 

Maximallast von 500g (Logger und Zubehör, bei 4-facher Sicherheit) tragen. Der Logger 

muss dabei vom Anwender immer beobachtet werden.  

Zur Vermeidung von Verletzungen ist wegen der starken Magnete der Logger wie 
abgebildet zu entfernen. 

  

 

 

 

   

 

 

 

 

 

 

Den Logger „abrollen“. 
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ELITEpro XC  Ein- und Ausgänge 

Der ELITEpro XC hat die folgenden Ein- und Ausgänge: 

• Bis zu 4 Eingänge für Stromzangen. 

• 4 Spannungseingänge (L1, L2, L3, und Neutral).  

• 4 Analogeingänge für Einheitssignale 0-10V oder 0/4-20mA zur Aufzeichnung von 

Prozessgrößen.  

• Spannungsein / -ausgang zur externen Stromversorgung des Loggers oder eines anderen 
Gerätes. Die Polarität ist am Gehäuse ersichtlich: 

 
In: 6-10 VDC, max. Eingangsstrom 500 mA 

Out: 6 VDC Ausgang, bis 200 mA zur Versorgung externer Geräte 

 

• USB- Schnittstelle für schnellen Datenaustausch mit dem PC und zur Stromversorgung vom 

PC. Bei Verwendung des Loggers in einer Verteilung darauf zu achten, dass das USB-Kabel 
einen Mindestabstand zu stromführenden Leitungen von min. 5 cm hat. 

• Ethernet –Schnittstelle zur Einbindung in ein LAN. 

• Koax-Anschluss für WiFi-Antenne kann vorhanden sein. (optional) 

 

Komplettierung der Verdrahtung 

Die folgenden Verbindungen müssen zur Installation des ELITEpro XC vorgenommen werden.  

Alle Arbeiten müssen von einer qualifizierten Fachkraft mit ordungsgemäßer Sicherheitsausrüstung 
ausgeführt werden. 
 

Anschluss der Stromzangen 
 
Zur Auswahl der Zangen siehe Schnellstart-Anleitung Seite 12 

1. Die Zangeneingänge des ELITEpro XC sind mit CH 1, CH 2, CH 3 und CH 4 beschriftet. Die 

Anschlussdrähte mittels kleinem Schraubendreher in einem Klemmenblock festziehen, siehe 

auch Bild auf Seite 5 der Schnellstart-Anleitung. Bei Rogowski-Spulen zusätzlich den Schirm 

anschließen an die rechte äußere Klemme, markiert mit “S” (Schirm). 

2. Anbringen der Zangen an den zu messenden Adern der Last, auf Phasenzuordnung wie im 

Spannungspfad achten.  

 
DENT Instruments Stromzangen sind folgendermaßen anzuschließen: 

• Split-core Stromzange (abnehmbares Joch): weißer Draht ist (+) schwarzer ist (-). 

• Stromzange: der gestreifte Draht mit Nummer 1 ist (+), der nicht gestreifte ist (-). 

• Rogowski-Spule: weißer Anschlussdraht ist (+), der braune ist (-).  

Blanken Draht an “S” (Schirm) anschließen.  
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Verbinden des Jochwandlers mit der Last 

1. Öffnen des Wandlers durch Abziehen des Joches. 

 

 

 

2. Zu messendes Kabel in den Kern einlegen, die maximale Stromstärke im Kabel darf die max. 

Belastbarkeit des Wandlers nicht übersteigen.  

 

 

 

 

Wandler schließen, auf glatten Übergang zwischen Joch und Kern achten.  

3. Schritt 1-3 für weitere Wandler wiederholen.  
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4. Weißen Draht an (+) anschließen.  

5. Schwarzen Draht an (-) anschließen.  

6. Messung beginnt. 

 

 

 

 

 

 

 

ELITEpro XC Spannungs- und Stromanschlüsse 

 

 

Stromzange 1 muss mit der als V High in der ELOG Setup-Tabelle zugeordneten Phase 

korrespondieren. Gleiches gilt für Zange 2 bis 4 

Beachte: Die richtige Polarität des 

Zangenanschlusses muss zur korrekten 

Darstellung der Phasenlage 

gewährleistet sein. Der Pfeil auf der 

Zange muss in Richtung Last zeigen. 

Andernfalls sind die auf der Zange 

aufgedruckten Anweisungen zu 

befolgen. 

Spannungsan- 

schlüsse 

Stromkanäle 
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Anschluss der Rogowski-Spule (Flex-Wandler) 

 

1. Öffnen des Wandlers durch Drücken der 

Schnappverbindung und auseinanderziehen.  

2. Schließen des Wandlers um den zu messenden Leiter, 

der Pfeil muss in Richtung Last zeigen. Der maximale 

Leiterstrom darf den Wandler nicht überlasten. 

 

 

 

 

 

Anschluss an den ELITEpro XC:  

1. Weißen Anschlussdraht an (+). 

2. Braunen Anschlussdraht an (-). 

3. Blanken Draht an “S”, zur Reduzierung  

von Übersprechen 

 

 

 

 

 

 

 

 

Anschluss Rogowski-Spule an ELITEpro XC 

Shield Wires from DENT RoCoil CTs 
connected to ELITEpro SP 

Negative 

Positive 

Shield 
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Spannungsanschlüsse 

1. Anschließen der Spannungsmessleitungen L1, L2, L3 

und Neutral (noch nicht mit dem Logger verbinden) 

mittels Kroko-Clips oder geeigneter Adapter 

möglichst nah an der Sicherung des zu messenden 

Gebäude-Stromkreises. 

 

a. Beachte den Anschlussplan im Abschnitt 2 

und geltende Vorschriften für die 

Installation. 

b. Wichtig:  
Überprüfen, dass die Sicherung als Trenner für den ELITEpro XC gekennzeichnet ist 

2. Anschließen der Messleitungen an die 4mm Sicherheits-Buchsen des ELITEpro XC 

 
 
 

Analoge Eingangskanäle/Stromversorgung 
 

Der ELITEpro XC verfügt über 4 analoge Eingangskanäle, die in beliebiger Kombination 

als 0-10V Spannungs- und/oder 0/4-20mA  Stromkanal konfiguriert werden können.  

 
Technische Spezifikation  
Maximale Eingangsspannung 30 VDC, unipolar, nur Messung.  

Maximaler Eingangsstrom  23 mA 

Beachte: Falls als Stromeingang konfiguriert, wird 

bei Anlegen einer Spannung schon unterhalb von 

30VDC bzw. bei Vertauschen der Polarität der 

max. zulässige Eingangsstrom überschritten.  

A/D - Wandler 16 bit  

Eingangsimpedanz  50.0 kOhm (Spannungseing.), 499 Ohm 

(Stromeingang)  

Kanal-Abtastrate  4 Hz– pro Kanal, 16 Hz insgesamt  

Genauigkeit <0.2% typisch 

 

Die folgenden Transmittertypen werden von der ELOG™ Software unterstützt:  

 

� 0/4–20 mA extern gespeiste Stromschleife  

� 0–30* VDC unsymmetrisch, nicht isoliert  
 
 

Beachte: Die Eingänge des ELITEpro XC sind bei vertauschter Polarität nur bis zu einer Spannung von 

15V dauerhaft gegen Zerstörung geschützt, der maximale Eingangsstrom beträgt 23mA. 

 

Beachte: Der ELITEpro XC  ist nach 

Überspannungskategorie III spezifiziert. 

Kat. III-Umgebung ist z.B. bei 

geschlossenen Gebäuden mit 

Schaltschränken, Verteilerkästen, 

Steckdosen der Festinstallation, 

Schaltern, Sicherungen, elektrischen 

Ausrüstungen für industrielle 

Verwendung oder auch stationären 
Motoren mit Festanschluss gegeben. 
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Achtung: Stellen Sie sicher, dass die Strom- bzw. Spannungsgrenzen nicht überschritten 
werden und die Kanäle in der ELOG Software richtig konfiguriert sind, bevor ein 
Transmitter angeschlossen wird. Dauerhaftes Überschreiten der Grenzwerte kann den 
Logger beschädigen und führt zum Verlust der Garantie. 

 
 

 

        
                

 

Achtung: Stellen Sie sicher, dass Spannungstransmitter immer mit der richtigen Polarität 
angeschlossen werden, da die sonst fließenden Ströme den Logger beschädigen können 
und die Garantie erlischt. 

 

 

Der Kanaltyp (Spannungs- oder Stromeingang) sollte vor Anschluss eines Transmitters in der ELOG-

Software konfiguriert werden. So kann verhindert werden, dass Spannungstransmitter niederohmig 
belastet werden oder Stromtransmitter in nicht geschlossener Schleife betrieben werden. 

Die erste Spalte auf dem Bildschirm zeigt den physikalischen Bereich des Transmitters, hier können 

die Min.- und Max.-Werte der Prozessgröße eingetragen werden. In der zweiten Spalte sind die 

elektrischen Ausgangsgrößen einzutragen, d.h. Min.- und Max. -Werte von (Ausgangs-) Spannung 

bzw. Strom des Transmitters. In der Regel sind sowohl die physikalischen als auch die elektrischen 

Werte auf dem Typenschild des Transmitters (oder im Datenblatt) ersichtlich. 

 

 

                                                                
         

                                                        Beispiel Typenschild Transmitter 
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Beschaltung als Stromeingang  

Der ELITEpro XC™ nutzt einen 0.1% -Präzisionswiderstand von 499 Ohm zur Messung des 

Spannungsabfalls, der durch den vom Transmitter aufgeprägten Strom verursacht wird. 

Stromtransmitter werden typisch mit 24V DC gespeist. Der ELITEpro XC™  hat vier Messkanäle, deren 

negative Klemmen gemeinsam mit dem Bezugspotential für die Leistungsmessung verbunden sind 
(also nicht  potentialfrei sind!). Deshalb ist es zwingend erforderlich, dass der ELITEpro XC™ immer 

als letzte Komponente, am Bezugspotential angeschlossen wird. Zur Vermeidung von 

Erdausgleichsströmen sollten mehrere Transmitter möglichst von einer Spannungsquelle versorgt 

werden. 

 

                                                     
                                       2-Draht Transmitter (Current Loop Configuration) 

 

Beschaltung als Spannungseingang 

Zu beachten ist, dass der Transmitter mit der richtigen Polarität angeschlossen wird. 
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Stromversorgungsein-/ausgang 

Der ELITEpro XC kann hier extern stromversorgt werden, falls z.B. nur Ströme aufgezeichnet werden 

sollen oder keine andere Quelle verfügbar ist. Alternativ ist die 6V-Versorgung eines anderen Gerätes 

möglich. 

1. Für die Auswahl eines geeigneten externen Netzteils Dent Instruments kontaktieren. 

2. Der ELITEpro XC kann 6V DC mit bis zu 200mA für ein anderes Gerät liefern, wenn er über die 

Spannungsmessleitungen L1, L2 an das Netz angeschlossen ist.  

 

 

 

Kommunikation mit dem ELITEpro XC 

USB-Schnittstelle  

Siehe Schnellstartanleitung Seite 4. 

 

 

Weitere Kommunikationsschnittstellen 

• Der RJ-45 Sockel dient zur Ethernet Netzwerk Verbindung 

Beachte: Die Ethernet- (LAN-) Verbindung gewährleistet einen schnellen 

Datentransfer vom und zum PC. Bei Verwendung eines Ethernet-Kabels in einer 

Verteilung ist ein Mindestabstand von 5 cm zu stromführenden Leitungen und 

Kabeln einzuhalten. 

• Die Koax-Buchse dient einer optionalen WiFi-(WLAN) Verbindung. 

Beachte: Wenn die Antenne innerhalb einer Verteilung genutzt werden soll, muss 

ein Mindestabstand von 5 cm zu stromführenden Leitungen und Kabeln eingehalten 

werden. 

• Eine interne Bluetooth wireless technology Antenne ist Option. 

 

USB Port Stromversorgungsein-

/ausgang 
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1. Nach Verbinden des ELITEpro XC mit dem PC per USB-Kabel startet ELOG automatisch und 

stellt die Verbindung zum Logger her. Wenn nicht, dann Doppelklick auf das ELOG-Icon auf 

dem Desktop. 

 

Das ELOG Fenster öffnet sich, 
die Menüs sowie eine Reihe 

von “Speedbuttons” 

(Schaltflächen für 

Schnellzugriff) werden angezeigt. 

 

Der ELITEpro XC und die ELOG Software sollten automatisch verbunden werden. Wenn nicht, 

mit Punkt 2 fortsetzten, sonst mit Punkt 6. 

2. Wähle Tools > PC Setup um das 

ELOG PC Setup Fenster zu öffnen.  

 
3. Links unten auf dem Bildschirm 

steht Direct Connect, wähle aus 

dem Menü den Port, der dem Com-

Port entspricht, mit dem das USB-Kabel verbunden ist.  

 

Port Preferences: Diese Option beinhaltet das Verbergen von COM Ports, Ändern der 

Reihenfolge von COM Ports, wie sie im Auswahlfenster erscheinen und wie gesucht wird, 

wenn ELOG den Logger nicht am gewünschten Port verbinden kann. Ungeprüfte Ports 

werden von ELOG verborgen. Gelistete und gesuchte Ports werden in Reihenfolge angezeigt. 

Diese kann durch Auswahl eines Ports und bewegen nach oben oder unten verändert 
werden. 

 

Immer wenn ELOG eine Verbindung zum Logger herstellt, wird der genutzte Port an die 

Spitze der Liste gesetzt. 

 

Enable features of older loggers: Ohne Bedeutung für Neukunden. 

 

 

BEACHTE: Schnelles PC-Setup durch Klicken auf  
 PC Setup speed button. ELOG zeigt in der Auswahlliste 

“Friendly Ports” an, so dass auf bequeme Weise 

ersichtlich ist, wo ein Anschluss möglich ist. 

Ethernet Anschluss 

(Standard) 

Externe Antenne 

für WiFi (optional) 
 

interne WiFi Antenne sowie 

interne Bluetooth Antenne 

(optional)
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4. Klick Save Changes. 

 

 

 

 

Für weitere Informationen über 
andere ELOG PC Setup Optionen 

siehe Tools Menu im Abschnitt 2. 

 

 

 

5. Wähle Logger > Communication > Direct Connect um den PC mit ELITEpro XC zu verbinden. 

 

Es wird ein Fenster mit Statusmeldungen über die Verbindung vom PC zum Logger angezeigt. 

Gleichzeitig beginnt COMM-LED am Logger zu blinken.  

 
 

   

 

 

 

  Verbindung hergestellt 

 

 Für weitere Informationen zu ELOG, siehe Abschnitt2.3. 
 

 

BEACHTE: 

Für schnelle Verbindung nutze  Direct Connect button. 

Für schnellen Abbruch nutze  Disconnect button. 
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6. Erstelle und übertrage ein Setup an den Logger. Siehe dazu Abschnitt 2.1 

 

7. Überprüfe mit den angezeigten Echtzeit-Messwerten die Installation. 

 

Abbruch der Verbindung vom ELITEpro XC zum PC 

Um die Verbindung von PC und ELITEpro XC zu beenden, wähle 

Logger > Communication > Terminate Connection. 

 

 

BEACHTE: Nutze den 

disconnect  speed button 

für schnellen Abbruch 
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ABSCHNIT 2.1: ERSTELLUNG EINES LOGGER-SETUPS 

Die Flexibilität des ELITEpro XC die Konfiguration der Messung mittels einer Setup-Tabelle. Das Gerät 

erlaubt die Aufzeichnung einer Vielzahl von Parametern in großen Strom- und Spannungsbereichen. 

Dies erfordert die Festlegung was und in welchen Zeitintervallen aufgezeichnet werden soll.  

• Die Setups werden mit der ELOG Software erstellt und im PC gespeichert. Die 
entsprechenden Dateinamen sind mit der Erweiterung “.sut“ versehen. Diese Dateien 

• Können unmittelbar im ELITEpro XC gespeichert werden, oder zu einem späteren 

Zeitpunkt, aber vor Beginn einer Messung 

• Können zu mehreren Loggern übertragen werden 

• Können vom ELITEpro XC zurückgeladen, verändert, gespeichert  

und neu geladen werden 

Ein im Logger vorhandenes Setup zurückladen 

Nach Herstellung der Kommunikationsverbindung  

1. Wähle Logger > Retrieve Logger Setup Table. 

 

Der Name der Setup-Datei ist in der oberen Menüleiste ersichtlich. Die Datei kann jetzt 

verändert und zurückgeladen werden. 
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Öffnen einer Setup-Datei 

  

2. Wähle File > Open zur Anzeige der “Öffnen-Box” 

 

 

2. Wähle Setup Table File und klicke auf OK.  

3. Wähle die Setup Datei oder navigiere zu einem Ordner mit zusätzlichen Dateien.  

Default-Einstellung ist: C:\Users\User Name\Documents\ELOG\Setups.  

4. Wähle den Datei-Namen und klicke Open. 

 

Anweisung zur Übertragung des Setups an den Logger siehe unten. 

 

Erstellen eines neuen Setups 

Ein Setup kann für jedes Gerät, das kompatibel mit ELOG ist, erstellt werden. Das schließt neben 

ELITEpro XC weitere ältere Geräte von DENT Instruments ein. 

Falls keine Logger an den PC angeschlossen ist 

3. Wähle File > New, Wähle Setup Table File. Klicke OK. 

 

Falls Verbindung zum ELITEpro XC besteht, nimmt ELOG an, dass das Setup für das 

angeschlossene Gerät erstellt werden soll. Klick auf New zeigt ein Setup mit voreingestellten 

Parametern. Wenn kein ELITEpro XC oder anderer Logger angeschlossen ist, erscheint das 

Select A Setup Table Type Fenster.  

2. Wähle ELITEpro XC aus dem Auswahl-Menu.  

3. Klicke OK. 
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Konfiguration des Setups 

Das Setup besteht aus einzelnen Abschnitten zur Definition der Attribute des ELITEpro XC .  

 
 

Logger Type ELITEpro XC ist der Default-Eintrag. Dieser Eintrag kann hier nicht 

verändert werden, der Logger-Typ muss im Select A Setup Table Type 

Fenster ausgewählt werden. 

Setup Table Name Name für das Setup vergeben, max. 20 Zeichen. 

Data Interval Hier wird festgelegt, in welchem Zeitabstand Daten gespeichert 

werden. Die Default-Einstellung ist 15 Min. Gewählt werden können 1, 
3, 15, 30 Sekunden; 1, 2, 5, 10, 15, 20 und 30 Minuten; 1 und 12 

Stunden; 1 Tag.  

Beispiel: Bei einer Integrationszeit von 30 Min. werden (so im Setup 

eingestellt) Min-, Max- und Durchschnittswerte aus ca. 600 

Messwerten gebildet und gespeichert. Der gespeicherte 

Energiemesswert ergibt sich aus dem Integral der Leistungsmesswerte 

der vergangenen 30 Min.  

Line Frequency Netzfrequenz 60 Hz oder 50Hz. Achtung : Werkseinstellung ist 60 Hz.  

 

 
 

Steuerung der Aufzeichnung  

In diesem Abschnitt werden die Bedingungen für Beginn und Beendigung der Messung definiert. Die 

Default- Werte sind Start Immediately (sofort) und Stop Never (Ringspeicher).  

 

 
 

 

 

Start Optionen  
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Immediately Die Aufzeichnung beginnt unmittelbar nach Senden des Setups an 

den Logger. 

Date (mm/dd/yy) 
Time (hh:mm:ss) 

Die Aufzeichnung startet zum eingestellten Zeitpunkt.  

Datumsformat: Monat/Tag/Jahr  
Zeitformat: Stunde:Minute:Sekunde 

Peak Demand 
Window 

Voreinstellung 15 min; mögliche Einstellungen: Off, 1, 2, 3, 4, 5, 6, 

10, 12, 15, 20, 30 und 60 min 

Stop Optionen 

Never (Ring Memory) Kontinuierliche Aufzeichnung: wenn der Speicher voll ist werden die 

ältesten Daten überschrieben (für Langzeitmessungen). 

When Memory Is Full Messung wird bei vollem Speicher beendet. 

 

Date (mm/dd/yy) 
Time (hh:mm:ss) 

Die Aufzeichnung stoppt zum eingestellten Zeitpunkt. Formate s.o. 

 

Speicherkapazität 

ELOG berechnet ständig die Aufzeichnungsdauer in Abhängigkeit der eingestellten Messparameter, 

so dass bei Änderungen von Parametern, die den Speicherbedarf beeinflussen, sofort die 

Auswirkungen auf die Messzeit sichtbar sind. Die Speicherkapazität beträgt 16 MB. 

 

 

Schnelleinstellungen 

Es stehen 4 Buttons (Schaltflächen) zur schnellen Konfiguration des ELITEpro XC zur Verfügung. 

4. Klicke den Button, der 

die erforderliche 

Messsituation 

darstellt. 

 

Ein Fenster zur 

Stromzangenauswahl 
wird dann geöffnet.  

 

Der View Typical Setup Button erscheint nach Vervollständigung eines Quick Setups. 

 

Siehe ELOG Quick Setups am Ende von Abschnitt2.1 für Einzelheiten. 
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2. Eingabe von CT Amps, d.h. den Messbereich des verwendeten Stromwandlers.  

 

Voreinstellung ist 100A. Der 

zu verwendende Wert ist auf 
der Stromzange 

aufgedruckt. Eintrag ändern 

falls notwendig und OK.  

 

3. Eingabe der 

Phasenverschiebung der 

Zange falls abweichend von 

der Voreinstellung, oder 

Rogowski-Spule (Flex-

Wandler) einstellen. 
 

 

 

Es werden zwei neue Fenster angezeigt: 

• View Typical Setup – Es wird ein Anschluss (Verdrahtungs-) plan für den Logger, bezogen 

auf die gewählte Messsituation, dargestellt. Für detaillierte Informationen zu jeder Quick 

Setup –Option wird auf ELOG Quick Setups and Wiring Diagrams verwiesen. Klicke OK 

um den Bildschirm zu schließen. 

• Calculated Power Channels – In der unteren Hälfte des Setup-Fensters werden die 

Optionen zur Konfiguration der berechneten Messkanäle angezeigt. 

 

Konfigurierung eines Physikalischen Leistungsmesskanals 

Der ELITEpro XC hat vier konfigurierbare Strom- und Spannungskanäle.  

1. Bildschirmdarstellung maximieren falls erforderlich. 

2. Klicke auf “Pfeil nach unten” neben jeden Kanal, der konfiguriert werden soll.  

3. Wähle Power zum Aktivieren der einzelnen Kanäle. 

 

Diese Kanäle beziehen sich auf die Stromwandlereingänge des ELITEpro XC. Bei 

Auswahl von Power werden die Optionen für die Konfiguration dieses Kanals 

dargestellt. 

4. Dann kann der Kanal benannt werden, und wähle Voltage References, Current Transformers 

und Recorded Values (Spannungsbezug, Stromwandler und Aufgezeichnete Werte) 

Beachte: Das PT Ratio, unter Voltage References, ist das Übersetzungsverhältnis 
eines Spannungswandlers, und zwar als Verhältnis von Sekundärseite zu Primärseite. 

Phase Shift, unter Current Transformers, ist der Wert, der zur Kompensation der 

Phasenverschiebung der Stromwandler nötig ist. Dieser beträgt bei den DENT-

Wandlern typisch 1.1 Grad und ist als Default-Wert eingetragen.  
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Die folgenden Optionen sind zur Konfigurierung physikalischer Messkanäle verfügbar. 

 

 

 
 

 

 

 

 

 
Name Benennung der Messstelle. Optionen 

V High Spannung bezogen auf Null-Potential,  

V Low.  

Auswahl: L1, L2, L3, Neutral. 

V Low Bezugspotential.  Auswahl: L1, L2, L3, Neutral. 

PT Ratio Übersetzungsverhältnis des Spannungs- 

Wandlers. Notwendig, wenn 

Spannungen höher als 600V gemessen 

werden sollen.  

Default: 1,000 

Type Stromzangen- oder Wandlertyp Auswahl: MilliVolt oder RōCoil. 

Amps Abhängig vom gewählten Wandlertyp. 

Angezeigt wird der Wert, der bei 
Auswahl des Wandlers eingetragen 

wurde. 

 

Phase Shift Phasenverschiebung des Stromwandlers Default: 1,1Grad 

Volts 
Amps 
KW 
KVA 
PF 
KVAR 

Spannung 

Strom 

Scheinleistung 

Wirkleistung 

Leistungsfaktor (cos phi) 

Blindleistung 

Auswahl :  

Average (Durchschnitt), 

Minimum, oder Maximum. 

Zusätzlich, wo passend, die 

zeitlichen Integralwerte 

(Energiemessung). 

 

Siehe auch Abschnit 2.2: Leistungs-/Energiemessung-Anschluss der Wandler und Konfiguration der 

Kanäle für weitere Informationen zum richtigen Setup für2-/3-/4-Leitermessung. 
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Kanäle für berechnete Parameter- Energiemessung 

 

Die Kanäle 5 und 6 dienen der Anzeige berechneter Größen. Hier werden Daten der physikalischen 

Kanäle 1 bis 4 ausgewertet. Sie können vor allem zur Berechnung von Summengrößen in 

mehrphasigen Systemen genutzt werden. Eine weitere Möglichkeit wäre auch, den Speicherbedarf 

für die Aufzeichnung durch Kombination von Daten eines Kanals oder mehrerer Kanäle zu 

optimieren. 

 

Siehe Anhang F für eine Beschreibung der Formeln, die zur Berechnung der Kanäle 5 und 6 (bezogen 

auf die Stromkanäle 1 bis 4) genutzt werden. 

Kanal 5 und 6 erscheinen automatisch, s. o.  

Default-Einstellung ist „off“(aus). 

 

 

 

 
 

 

Kombination von Kanälen zur optimalen Speicherplatznutzung: 

1. Abhängig vom Setup die benötigten und zu kombinierenden physikalischen Kanäle auf 

„Power“ stellen. 

2. Um den Speicher maximal zu nutzen, entferne alle Häkchen in Recorded Values für Volts, 

Amps, kW, kVA, PF, und kVAR der einzelnen Kanäle. Bitte beachten, dass in der 

Voreinstellung ist bei allen Werten „Average“ (Durchschnitt) aktiviert ist. 

3. Calculated Power Channels (berechnete Kanäle 5 und 6) durch Auswahl von Power Sum 
aktivieren, Kanal 6 nur wenn benötigt, dann Namen vergeben. 

4. Im Combine Channels Kasten Häkchen bei den zu kombinierenden physikalischen Kanälen 

setzen. 

5. Häkchen setzen für (und/oder) Volts, Amps, kW, kVA, PF und kVAR wie aufgezeichnet 

werden soll 

6. Mit Send Setup Table to Logger Button dieses Setup zum Logger übertragen. 

 

 

 

BEACHTE: Die Kanäle 5 und 6 werden nicht angezeigt, wenn nur ein physikalischer Kanal konfiguriert 

ist. Bei nur zwei konfigurierten physikalischen Kanälen wird nur Kanal 5 angezeigt. 
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Das folgende Beispiel zeigt das Setup für die Messung einer dreiphasigen Last in Sternschaltung mit 

Kombination der Kanäle 1, 2, und 3. 

 

 
 

Analoge Ausgangskanäle 
 

 
 
1) Wähle Spannung/Strom / aus, die zusätzlichen Felder öffnen sich bei Auswahl von Spannung oder 

Strom.  

2) Auswahl eines Namens für den Transmitter, dieser Name erschient dann als Kopfzeile der 

entsprechenden Meßdaten. 
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BEACHTE: Wenn per “Speed-Button” ein 

Standard-Setup erstellt wurde, erscheint ein neuer 

“Speed Button” View Typical Setup. Dieser Button 

erzeugt eine graphische Darstellung, wie der 

ELITEpro XC mit der Last zu verbinden ist. Das Bild 

kann ausgedruckt und als Arbeitsanleitung 

genutzt werden.  

Speichern eines Setups auf dem PC 

Nach Beendigung der Konfiguration kann das Setup auf dem PC gespeichert und später zum Logger 

übertragen werden. 

Wähle File > Save zum speichern, oder Save As, 
um unter einem anderen Namen/ in einen 

anderen Ordner zu speichern.  

 

 

 

 
 

Übertragen des Setups zum Logger 

Nach Fertigstellung der Konfigurationseinstellungen muss das Setup zum Logger übertragen werden. 

5. Nach Anschluss des Loggers an den PC, klicke auf den Send Setup Table to Logger Button auf 

dem Setup-Bildschirm. Ein neues Setup löscht alle vorhandenen Daten auf dem Logger. 

 

6. Es erscheint 

eine Dialog-

Box, die 

sicherstelle

n soll, dass 

keine noch 

benötigten 

Daten gelöscht werden. 

 

7. Auswahl:  Setup senden und Daten löschen - Daten sichern, dann Setup senden - Abbruch 

8. Um Echtzeit-Messwerete anzuzeigen,wähle Logger > Display Real-Time Values > Show As 

Text. 
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LED Statusanzeigen 

PhaseChek™ LED’s 

PhaseChek ist eine einzigartige Eigenschaft des ELITEpro XC, 

welche den Anschluss des Gerätes durch Sicherstellung 

richtiger Stromzange-zu-Phase-Beziehung vereinfacht und 

fehlerhafte Datenaufzeichnung vermeidet.  

 

Der ELITEpro XC hat vier tri-color PhaseChek LEDs, ein Paar 

rot/grün/blau  pro Kanal: 

• Alle LEDs sind grün- der System-Leistungsfaktor ist 

größer als 0,55 und die Wandler sind auf der 

entsprechenden Phase richtig platziert. 

• LED ist rot — Strom- und Spannungsphase stimmen nicht überein oder Leistungsfaktor 

kleiner 0,55 

• LED ist blau – Stromzange ist in entgegengesetzter Orientierung angeschlossen (Pfeil nicht 

zur Last) 

• LED blink rot und blau- Phasen- und Richtungsfehler (s.o.) 

• Bei nicht konfigurierten Kanälen leuchtet die LED nicht 

.  

COMM – Kommunikations-LED 

Die ELITEpro XC COMM LED kann in den Farben rot, grün oder blau blinken, welche 

Statusinformation signalisiert wird hängt von der Firmware-Version des Loggers ab. Immer gilt: wenn 

die LED ca. 1x pro Sekunde grün blinkt, zeichnet der Logger auf und Verbindung zum PC besteht. 

Beachte: Wenn der Summen-
Leistungsfaktor kleiner als 0,55 ist, 
leuchten die LED`s rot, obwohl die 

Wandler richtig angeschlossen sind. 

Diese Situation ist selten, kann aber 

z.B. bei einem gering belasteten E-

Motor vorkommen.  Das der 

Leistungsfaktor einer einzelnen 
Phase kleiner als 0,55 ist, ist nicht 

ungewöhnlich und die entsprechende 

LED ist rot. 
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ELOG Quick Setups 

Die folgenden Graphiken zeigen die Anschlusspläne des ELITEpro XC bei unterschiedlichen Last-

Situationen 

 

Einphasig, 2-Draht 

Konfiguriere das Setup wie folgt: 

 

Anschluss der Messleitungen und Wandler: 

 

ELITEpro XC Anschlussbild 1-phasig, 2 Draht 

Hinweis: Die Verbindung N zu L2 des ELITEpro XC dient der Spannungsversorgung des Loggers 
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Einphasig, 3-Draht 

Konfiguriere das Setup wie folgt: 

 

Anschluss der Messleitungen und Wandler: 
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Dreiphasig, Dreieck 

Konfiguriere das Setup wie folgt: 

 

Anschluss der Messleitungen und Wandler: 
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Dreiphasig, Stern 

Konfiguriere das Setup wie folgt: 

 

Anschluss der Messleitungen und Wandler: 
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ABSCHNITT 2.2: LEISTUNGSMESSUNG – ANSCHLUSS DER 
WANDLER & KONFIGURIEREN DER KANÄLE 

Leistungsmessung  

Der ELITEpro XC™ kann zur Messung an ein- oder mehrphasigen AC-Lasten mit Spannungen bis 600V, 

50Hz oder 60Hz eingesetzt werden. 

Bitte die Beschreibung aller Warnsymbole beachten, siehe Abschnitt Sicherheit am Anfang des 
Handbuchs. 

Zur Auswahl der richtigen Stromwandler siehe Abschnitt Stromwandlerauswahl weiter unten. 

 

 

VORSICHT: KEINE WANDLER OHNE ABSCHLUSSWIDERSTAND BENUTZEN, SONDERN 

NUR SOLCHE MIT 333 mVAC AUSGANG. BEI ALLEN DARSTELLUNGEN IN DIESEM 

ABSCHNITT ZEIGT DER « PHASEN-PFEIL »DES WANDLERS IN RICHTUNG LAST.  

Falls verfügbar, den weißen Neutralleiter mit der N-Sammelschiene verbinden. Bei Messungen an 

Dreieckschaltungen N-Messleitung mit Phase L2 oder L3 verbinden. 

 

 

WARNUNG: Nichtsachgemäßer Gebrauch des Gerätes kann die Schutzfunktionen 

beeinträchtigen. Die maximale Eingangsspannung von 600V darf nicht überschritten 
werden!  

 

 

Bei Anschluss des ELITEpro XC an eine AC-Last sind folgende Schritte auszuführen, um 

die Gefahr eines elektrischen Schlags zu vermeiden: 

1.  Der zu messende Stromkreis muss entladen werden. 

2.   Stromzangen an die zu messenden Kabel anbringen. 

3.   Gerät mittels Spannungsmessleitungen mit den einzelnen Phasen verbinden.  

       Benutzen Sie die für die zu messenden Spannungen erforderliche  

       Sicherheitsausrüstung (Handschuhe und Schutzkleidung). 
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Vereinbarungen zur Bezeichnung der Messleitungen 

In den in diesem Handbuch dargestellten Anschluss-/Verdrahtungsplänen  

wird der in den USA gebräuchliche Farbcode für die einzelnen Phasen verwendet: 

 

(Farbe der Phasen) 
Spannungsphase  

USA DIN VDE 0293-308 

L1 Schwarz Braun 

L2 Rot Schwarz 

L3 Blau Grau 

Neutral N Weiß Blau / Grün-Gelb 

 

Stromwandlerauswahl 
 

Beachte: Die folgenden DENT Instruments Stromzangen sind UL Anerkannt (UL Underwriters 

Laboratories ist ein unabhängiges Zertifizierungsinstitut) und sind nach IEC 61010-1 zertifiziert:  

 

CT-HSC-020-X (20A Mini), CT-HSC-050-X (50A Mini), CT-HMC-0100-X (100A Midi), und die 

CT-HMC-0200-X (200A Midi). Der Gebrauch anderer Stromzangen macht das UL Listing des 

ELITEpro XC ungültig. 

Die Auswahl eines passenden Wandlers ist zu Erzielung genauer Messergebnisse unerlässlich. Nutze 

den Wandler mit dem kleinstmöglichen Durchmesser und dessen Strombelastbarkeit die zu 
erwartende Maximalstromstärke nicht unterschreitet. 

Größte Messgenauigkeit wird erreicht, wenn die zu messende Stromstärke in der Nähe der 

maximalen Belastbarkeit des Wandlers liegt. Daraus folgt, dass Wandler, deren maximale Lastgrenze 

weit über der größten zu messenden Stromstärke liegt, nicht verwendet werden können. 

Die folgende Tabelle zeigt einige DENT Instruments Stromwandler (Split Core-Wandler mit 

abnehmbaren Joch): 

 

Mini 
Small 
Split 
Core 

Midi 
Medium 

Split 
Core 

Large Split Core Stromzange 
FlexWandler 
(Rogowski) 

20A 

5A/15A 

(high 

accuracy) 

100A 100A 600A 150A 5,000A 

50A 50A 200A 200A 1000A 500A 
RōCoil mV™ In 

verschiedenen 

Längen verfügbar. 

 100A  400A  1000A  

   600A    

Messbereiche von Wandlern, die bei DENT Instruments verfügbar sind 
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Alle Wandler haben einen Abschlusswiderstand für eine 

maximale Ausgangsspannung von 333 mV. Dies gewährleistet 

Sicherheit auch bei der Verbindung mit Starkstromkabeln. Die 

Gehäuseisolation ist für Spannungen bis 600V Phase-Phase 

ausgelegt, nicht bei höheren Spannungen verwenden!  

 

 

 

 

 
 

 

VORSICHT: KEINE WANDLER OHNE ABSCHLUSSWIDERSTAND BENUTZEN, SONDERN 

NUR SOLCHE MIT 333 mVAC AUSGANG. BEI ALLEN DARSTELLUNGEN IN DIESEM 

ABSCHNITT ZEIGT DER « PHASEN-PFEIL »DES WANDLERS IN RICHTUNG LAST. 

 

Beispiele für Auswahl des Wandlers 
 

Beispiele Beschreibung der Anwendung Passender Wandler 

1 
Einphasenmotor mit 10A Betriebsstrom, gesichert mit 

20A. 

20A oder 50A split core oder 

150 Zange 

2 
Vier Lichtstromkreise, gesichert jeweils 16A, 

Gesamtstrom 45 A 
50A Wandler 

3 Heizstromkreis, gesichert mit 60A. 100A Wandler 

 

BEACHTE: Bei Messungen an eingebauten Stromwandlern ist deren Übersetzungsverhältnis beim 

Erstellen des Setups mit einzurechnen. Dazu ist des Ü-Verhältnis des Einbauwandlers mit der 

Nennstromstärke des Wandlers am ELITEpro SP zu multiplizieren, z.B.: Einbauwandler -ÜV 4000:5, 

Wandler am Logger 50A, rechne (4000/5) x 50 =40.000 Dieser Wert wird im Setup als 

Stromzangenwert eingetragen. 

BEACHTE: Es können ohne 

Genauigkeitsverlust 

Anschlussleitungen bis ca. 4m 

Länge verwendet werden, wenn 

diese den Originalleitungen 

entsprechen. 
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Anschließen der Stromzangen/Messleitungen  
 

1. Die Anschlussleitungen der Wandler am schwarzen Klemmenblock einschrauben. Bei 

jedem Kanal ist das linke Pin (+), des Rechte (-)  

Von DENT Instruments gelieferte Wandler wie folgt anschließen: 

• Split-core Wandler (abnehmbares Joch) —Weiß ist (+ ), 

Schwarz ist (-) 

       Stromzangen—Rot ist (+), Schwarz ist (-) 

 

 

 

2. Anschließen der Wandler an die zu messenden Phasen unter Beachtung der Orientierung 

. 

3. Wenn ein Pfeil auf dem Wandler angebracht ist, muss dieser Richtung Last zeigen, oder 

die auf dem Wandler aufgebrachten Anweisungen befolgen (z.B. „diese Seite Richtung 

Last“) 

4. Spannungs-Messleitungen anschließen, N zuerst 

Beachte: Optional ist für den ELITEpro XC ein Steckernetzteil erhältlich. 

 

Beachte: Richtige Polarität 

ist notwendig für korrekte 

Phasenbeziehungen 

Stromzangenanschlüsse

Spannungsleitungs- 

Anschlüsse 
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ABSCHNITT 2.3: BESCHREIBUNG DER ELOG SOFTWARE 
Nach Start von ELOG erscheint folgendes Fenster mit Menüleiste und Buttons (Schaltflächen) für 

häufig genutzte Funktionen von ELOG.  

 
Menus 

Speed Button 
Toolbar 

 
 

 

 

 

 

 

 
 

 

 
 

 
 
 

 
 

Verbindungs- 

Fenster 
 

 
Status 

  

 

 

File Menu  

Das File > New Menu erstellt eine neue Datei. Es sind 4 Dateitypen für ELITEpro XC ™ Logger 

verfügbar. 
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ELOG Data File – beinhaltet vom Logger 

übertragene Daten. Wenn Verbindung zum 

Logger besteht, Dateiname eingeben für 

die zu übertragenden Daten. Wenn keine 
Verbindung besteht, fordert ELOG die 

Herstellung der Verbindung zu dem Logger, 

von dem die neuen Daten übertragen 

werden sollen. 

Graph File –beinhaltet graphische Darstellungen von Messdaten. Klick auf Graph File öffnet 

einen Ordner mit vorhandenen Dateien. 

Logger List File – zeigt Typen von Loggern an, die AutoPoll nutzen, eine Windows-

Anwendung zur automatischen Daten-Übertragung.  

Setup Table File – Wenn keine Verbindung zum Logger besteht, fordert ELOG “Select the 

logger type “ (Typ auswählen, also ELITEpro XC) für den ein neues Setup erstellt werden soll. 
Wenn Verbindung besteht geht ELOG davon aus, dass das Setup für den angeschlossenen 

Logger erstellt werden soll. 

 

DATEI ÖFFNEN 

Das File > Open Menu öffnet eine vorhandene 

Datei und fordert die Auswahl des Dateityps. Ob 

Verbindung zum Logger besteht hat hier keinen 

Einfluss. 

 

DATEI SPEICHERN 

Mit File > Save und File > Save As können alle 

Dateien gespeichert werden. Save As erlaubt die Speicherung unter neuem Namen oder in 

einem neuen Ordner.  

 

DATEIEN EXPORTIEREN UND IMPORTIEREN 

File > Export Data File gestattet den Export von Daten in eine *.csv – Datei zur Nutzung der 

Daten anderen Anwendungen. 

File > Import CSV File gestattet den Import von Daten aus * .csv – Dateien zu ELOG. 

Anmerkung:  Dent verwendet die „amerikanische“ Excel-Version, d.h., die Dezimalstellen  
werden per Punkt getrennt, die Spalten mit Komma separiert. Dies hat zur Folge, daß die Daten 

nach dem Export in das „deutsche“ Excel  auf das hier übliche Format mit der Funktion „Daten- 

Text in Spalten“ konvertiert werden müssen, also Dezimal-Komma, Spalten mit Semikolon 

getrennt.  Möglicherweise müssen auch die Dezimalstellen mit einem Faktor korrigiert werden. 
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View Menu 

Das View (Anzeige-)Menu dient zur Anzeige von ELOG-

Funktionen im ELOG -Fenster. Jede Funktion kann durch 

anklicken ein-bzw. ausgeschalten werden. 

Das Connection Window zeigt bei bestehender 

Verbindung zum Logger Statusinformationen an. Details 

siehe Abschnitt 1 Kommunikation mit dem ELITEpro SP. 

Die Toolbar Option aktiviert/deaktiviert Buttons im 

Hauptmenu.  

Die Status Bar Option aktiviert/deaktiviert Information im unteren Teil des ELOG Fensters.  

 

Edit Menu 
 
Das ELOG Edit Menu hat die Windows-Funktionen  Cut, Copy, und Paste (Ausschneiden, Kopieren, 

Einfügen). 
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Logger Menu 

Das Logger Menu dient der Konfiguration des ELITEpro SP, der Anzeige von Echtzeitmessdaten, 

Übertragen der Logger-Daten und Einstellen von Kommunikationsparametern. 

 

Communication 

Herstellung der Verbindung zwischen PC und 

Logger, detaillierte Beschreibung siehe unten 

 

Retrieve Data From Logger 

Überträgt Daten vom Logger und speichert diese als 

*.elog Datei auf der Festplatte. Vor der 

Übertragung wird zur Eingabe eines Dateinamens 
aufgefordert. Der voreingestellte Name besteht aus 

der Seriennummer des Loggers und einer 

zweistelligen Zahl, die angibt, wie oft Daten vom 

Logger übertragen wurden. 

Zu übertragende Daten können an eine existierende Datei angehangen werden. Prüfe den 

Append New Data To Existing Data File Kasten und wähle aus, an welche Datei die neuen Daten 

angehangen werden sollen. 

Gleichzeitig kann beim Datenübertragen auch eine *.csv-Datei (ASCII-Datei) erzeugt werden, die 

dann von anderen Anwendungen gelesen werden kann. 

Mit Tools > PC Setup > Data Files Saved To: wird der Pfad eingestellt, wo die Daten 
abgespeichert werden sollen. Voreingestellt ist der Pfad 

C:\Users\UserName\Documents\DENT\ELOG\Data. 

Mit Data > Open Data File > öffnen der gewünschten Datei.  

Zum Exportieren einer Datei im .csv-Format siehe Abschnitt Datenexport. 

Display Real-Time Values 

Diese Option gestattet die Anzeige von in Echtzeit übertragenen Messwerten in graphischer oder 

in Textform. Eine detaillierte Beschreibung ist weiter unten verfügbar. 

Retrieve Logger Setup Table 

Senden, Empfangen, Verändern, Speichern des Logger-Setups. 

Logger Clock 

Einstellen von Datum und Uhrzeit für den Logger, manuell oder synchronisiert mit der PC-

Zeiteinstellung. Siehe auch Abschnitt Logger Clock  
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Edit Logger Description Line 

Vergabe eines Namens für den 

Logger, zur Unterscheidung, falls 

mehrere Logger im Einsatz sind. 

 

 

 

 

Logging ON/OFF 

Start/Stop der 

Aufzeichnung 

 

 

 
 

 

 

Clear Logger  

Daten erst löschen, wenn sicher ist, 

dass sie nicht mehr benötigt werden. 

Wiederherstellung von Daten ist 

nicht möglich.  
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Kommunikation mit dem Logger 

Direct Connect 
Verbindet Logger und PC via 

USB-Kabel. Die korrekte 
Verbindung wird im Connection 

window angezeigt. 

Network Connect 
Stellt eine Verbindung via LAN 

oder WiFi her. 

Choose From Last Used Logger 
List 

Die Verbindung wird mit dem zuletzt verwendeten Logger hergestellt. 

Cancel Communications Operation 
Kann zur Unterbrechung der Verbindung zum Logger genutzt werden. 

Terminate Connection 
Beendet die Verbindung zum Logger. 

Logger Network Setup 
Anschluss des Loggers per LAN, Eingabe von IP Addresse, Subnet Mask, Gateway Addresse und 

Local Port Nummer. Wähle Update Logger zur Bestätigung und Cancel zum Schließen des 

Fensters. 

Logger WiFi Setup 
Zur Herstellung einer WiFi-Verbindung existieren drei Möglichkeiten. Siehe Anhang G mit Schritt-

für-Schritt Anweisungen. 

(Optional) Logger Bluetooth Wireless Technology Connection 
Diese Option ist kein Punkt im Kommunikationsmenu, aber für Bluetooth wireless technology 

ausgestattete ELITEpro XCs von DENT Instruments verfügbar. Zur Herstellung einer Bluetooth-

Verbindung wähle Tools > PC Setup, dort in der Port-Auswahlliste den COM port für das 

Bluetooth wireless technology module (üblicherweise existiert ein Name, der sich auf das 

Bluetooth-Gerät bezieht). Wenn mehr als ein Bluetooth wireless technology COM port 

vorhanden ist, wird meistens der Port mit der niedrigeren Nummer genutzt. Wähle den COM 

port und klicke dann Save Changes. 

Zum Schluss wähle Direct Connection  aus der speed button toolbar, oder Logger > 

Communication > Direct Connection. 

Logger Properties 
Zeigt Inforamtionen zum gerade verwendeten Logger an, wie Typ, Version, Beschreibung und 

Seriennummer. Klicke OK zum Schließen des Fensters. 

AutoPoll 
AutoPoll ist ein eigenständiges Windowsprogramm (wird zusammen mit ELOG installiert), 

welches zur automatischen Datenübertragung von einer Reihe von Loggern genutzt wird. Eine 

komplette Beschreibung liefert Anhang E.  

 



 

 

PK elektronik Poppe GmbH Seite  

www.pk-elektronik.de 53 vertrieb@pk-elektronik.de 

 

 

Display Real-Time Values Menu Options  

Logger > Display Real-Time Values zeigt Echtzeit-Messwerte als Graph oder als Text. 

 

Show As Text 

Wenn diese Option gewählt wird erscheint ein 

Bild- schirm ähnlich dem unten angezeigten. 

Alle Kanäle, die eingeschaltet sind, werden 
gleichzeitig angezeigt (auch wenn nicht 

aufgezeichnet wird). Parameter, die 

aufgezeichnet werden, sind grün hinterlegt. Pro 

Power Channel werden alle sechs Parameter (V, 

A, kW, kVA, PF und kVAR) angezeigt, auch wenn 

nur einer davon aufgezeichnet wird. 

Diese Funktion ist sehr nützlich zur Überprüfung 

des korrekten Anschlusses des Loggers. 

Dieser Bildschirm bietet Informationen über: 

• Echtzeitmessdaten (Anzeige kann wegen Berechnungen pausieren) 

• Netzfrequenz, gemessen auf Kanal 1 

• Zeit bis Speicher voll 

• Datum und Uhrzeit des Loggers 

• Ob Aufzeichnung aktiviert ist oder nicht 

• Wieviel Speicher schon belegt ist 

• Speicherorganisation (linear oder Ring) 
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Show As Graphs 

Darstellung der Messwerte als y-t-Diagramm. 

Wähle Logger > Display Real-Time Values > Show as Graphs, angezeigt wird folgendes Dialog-

Fenster: 

 

Angezeigt werden: 

• Die gerade aktivierten (physikalischen)Kanäle. Die Auswahl eines Messkanals aktiviert die 

Parameters To Display Option. Man kann hier wegen Skalierungsproblemen im 

Unterschied zur Textformanzeige nur eine Variable zur Anzeige bringen. Es ist aber 

möglich, gleichzeitig von allen Kanälen einen Parameter darzustellen. 

Nach klicken von OK erscheint ein Bildschirm ähnlich dem hier gezeigten:  

 

Die graphische Darstellung ähnelt sehr dem Ausdruck eines y-t-Schreibers. Der Graph beginnt am 

linken Rand und bewegt sich nach rechts. Nach Erreichen des rechten Randes verschiebt sich der 

gesamte Graph nach links, so dass immer die letzten Messwerte angezeigt werden und die 

ältesten am linken Rand verschwinden.  
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Mit Set X –Funktion die Zeitachse skalieren (1 Sekunde bis 65.000 Sekunden/18Tage). Zu 

beachten ist, dass die Skalierung der Zeit-Achse nur angenähert ist 

Mit Set X and Y Axis Button die Skalierung verändern und Skalenart (linear oder logarithmisch) 

einstellen. 

 

Waveform Capture 

Wähle Logger > Display Real-Time Values > Waveform Capture zur Darstellung der Wellenform  

 

 

 

Harmonics 
Wähle Logger > Display Real-Time Values > Harmonics zur Darstellung des Oberwellenspektrums: 
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Mit den Buttons entlang der unteren linken Seite des 

Fensters den Kanal wählen. Nur ein Kanal kann 

gleichzeitig angezeigt werden. Die Harmonischen von 

Strom und Spannung stehen im oberen Teil des 
Fensters. Die y-Achse ist in Prozent der Grundwelle 

skaliert. Auf der x-Achse werden sowohl die 

geradzahligen als auch die ungeradzahligen Oberwellen 

dargestellt. 

 

Die Effektivwerte der Harmonischen von Strom und 

Spannung stehen im entsprechenden Kasten. Mit 

klicken auf die  Buttons kann die Ordnung der 

Oberwelle gewählt werden. In einem weiteren Fenster 

werden summarische Ergebnisse wie 
Gesamteffektivwert (RMS), Klirrfaktor (THD), 

Spitzenwerte, Crest-Faktor und K-Faktor angezeigt.  

 

Das Bild repräsentiert einen einmaligen Schnappschuss. 

Mit dem Update Button kann die Anzeige erneuert 

werden. Mit Copy wird das Bild in der Zwischenablage gespeichert. 

 

Logger Clock  
Einstellen von Logger-Datum und Uhrzeit mit: Logger > Logger Clock. Möglich sind manuelle 

Einstellung oder Synchronisation mit PC-Zeit. 

 

Manually Set Logger Time 

Manuelles Einstellen von Datum im Format 

MM/TT/JJ und der Uhrzeit im 24-Stunden-

Format.. 

Synchronize Time To Match PC 

Die interne Logger-Uhrzeit wird 

automatisch mit der PC-Zeit aktualisiert. 

Clear Logger  

Daten erst löschen, wenn sicher ist, dass 

sie nicht mehr benötigt werden. 

Wiederherstellung von Daten ist nicht 

möglich.  

 

Clear ALL Logger Data 

Alle Daten im Logger werden gelöscht. 

 

 

BEACHTE: Die Effektivwerte der 

Harmonischen können als prozentualer 

Anteil des Effektivwertes der Grundwelle 

(IEEE Standard 1035-1989) oder des 

Gesamteffektivwertes (RMS) (CSA und IEC 

Standard) berechnet werden. 

BEACHTE: Voreingestellt ist die 

Darstellung bis zur 31.Oberwelle plus DC-

Komponente. Um weitere Oberwellen 

anzuzeigen (bis zur 63.) Doppelklick auf 

die horizontale Achse von Strom und/oder 

Spannung. In der Dialogbox im “To” –Feld 

die Nummer der Oberwelle eintragen, bis 

zu der die Anzeige erweitert werden soll, 

dann ok klicken. 
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Tools Menu  

PC Setup 

Mit Tools > PC Setup werden die Pfade für die 

Abspeicherung der einzelnen Dateien festgelegt. 
 

Update Logger Firmware 

Falls die Meldung “The connected logger has 

firmware that is older than this version of ELOG supports, and may not operate properly with this 

version of ELOG” erscheint, siehe Anhang B, um ein Update der Logger-Firmware zu starten. 
 

PC Setup Options 

Data Files Saved To: Legt den Default -Ordner fest, in dem Daten gespeichert werden. Wenn 

beim Datenauslesen der Pfad Logger > Retrieve Data genutzt wird, werden die Daten im hier 

festgelegten Ordner abgelegt.  

Setup Files Saved To: Legt den Default -Ordner fest, in dem Setups gespeichert werden.  

Logger Files Saved To: Legt den Default -Ordner fest, in dem Logger-Dateien gespeichert werden. 

Bei Nutzung von AutoPoll, schaut ELOG zuerst in diesen Ordner. 

Direct Connect: Wähle den USB port des PC, mit der ELITEpro XC zu verbinden ist.  

 

ELOG ist mit der Funktion Friendly Ports™ ausgestattet. ELOG zeigt verfügbare Windows COM ports 

an. Einfach zu verstehende Gerätebeschreibungen erleichtern das Finden eines passenden Ports. 
 

Port Preferences: Diese Option beinhaltet: Verbergen von COM Ports, Ändern der 

Reihenfolge von COM Ports, wie sie im Auswahlfenster erscheinen und wie gesucht wird, 

wenn ELOG den Logger nicht am gewünschten Port verbinden kann. Ungeprüfte Ports 

werden von ELOG verborgen. Gelistete und gesuchte Ports werden in Reihenfolge angezeigt. 

Diese kann durch Auswahl eines Ports und bewegen nach oben oder unten verändert 

werden. 
 

Jedes mal, wenn ein Logger mit dem PC verbunden wird, erscheint die genutzte Schnittstelle an 

der Spitze dieser Liste. 

Enable features of older loggers: Nur für ältere Modelle von Loggern von Interesse,  

inaktiv lassen 
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Data Menu 

Die im ELITEpro XC gespeicherten Daten können an den PC übertragen werden. Die Datei kann 

geöffnet, graphisch dargestellt und zur weiteren Analyse exportiert werden.  

 

 

Create New Graph 

1. Falls eine Datei noch nicht geöffnet ist, wähle Data > Create New Graph zum Öffnen der 

graphischen Darstellung der Daten. Bei einer geöffneten Datei wird bei Anklicken dieses 

Menu-Punktes diese weiterhin genutzt. 

 

2. Per Mausklick die Parameter auswählen, die graphisch dargestellt werden sollen. Auswahl 
mehrerer Parameter durch gleichzeitiges Drücken der (Ctrl/Strg)-Taste oder der Shift -Taste 

zur Auswahl einer 

Gruppe von Parametern. 

3. Nutze Record Range um 

ersten und letzten 

darzustellenden 

Abtastwert zu 

definieren, oder wähle 

All Records um alle 

Werte anzuzeigen. 
Voreingestellt ist All 

Records, nach Entfernen 

des Häkchens können 

Start- und Stoppwert 

eintragen werden. 

 

Klicke Next um zum  

Set Graph Parameters Dialogfenster zu gelangen. Wähle den Typ des Graphen, der erzeugt 

werden soll.  

 

BEACHTE:  
Einige Menüpunkte sind nur sichtbar, 

wenn eine Daten-Datei geöffnet ist. 
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4. Unter Axes wähle den Graph Type im Auswahlmenu. Man kann auch das “Use Multiple Y 

Axes” Kästchen aktivieren, falls mindestens zwei Parameter zur Darstellung gewählt wurden. 

Nach klicken von Next werden die Möglichkeiten zur Zuordnung der y-Achsen gezeigt. 

5. Unter Options Häkchen (bzw. Punkt) setzen bei der gewünschten Funktion: 

Show graph data cursor – ein Cursor wird eingeblendet 

Show graph data points – Anzeige der Abtastpunkte, Zeitintervalle wie im Setup 

eingestellt 

Show analysis values – Anzeige summarischer Ergebnisse (Minimum, Maximum, 

Durchschnitt) 

Use default graph attributes – nutzt die Voreinstellungen von Farbe, Schriftart usw. 

Use current graph attributes – ruft die zuletzt genutzte Einstellung auf. 

6. Klicke Finish und eine graphische Darstellung ähnlich der unten gezeigten erscheint. Die 

Beschriftungsfarben sind den einzelnen Graphen zugeordnet. Klicken der rechten Maustaste 

öffnet ein Fenster mit weiteren Darstellungsoptionen (Cursor, Grid (Raster), Linienstärke, 
Hintergrundfarbe usw.) 

 

Die Cursorwerte werden links oben angezeigt. Doppelklicken irgendwo in der Graphik öffnet ein 

weiteres Dialogfenster für individuelle Einstellungen (Farben, Fonts (Schriftarten), Anzahl der 
Nachkommastellen usw.), ein Auswahlfeld für den Daten-Export und ein Auswahlfeld zur 

Maximierung der Darstellung auf den vollen Bildschirm(zurück mit „ESC“-Taste). 

 

• Die Graphen wie auch andere Dateitypen (Data, Setup Tables, Logger Lists) können 

mittels des Kommandos File > Print… (oder Ctrl + P) ausgedruckt werden. 
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Graph Options 

Die Graph Options Funktion erlaubt verschiedene Voreinstellungen für die Erstellung eines neuen 

Graphen. 

 

Graph Data Cursor: Der Cursor wird, sobald aktiviert, immer mit der Maus bewegt, wenn sich 

der Mauszeiger innerhalb der Graphik befindet. Die statische Veränderung der 

Cursorposition erfordert gleichzeitiges Drücken der linken Maustaste. Der Mauszeiger muss 

dabei parallel zum horizontalen Bildrand bewegt werden, der Cursor erscheint erst wieder 
nach loslassen der Taste. Es wird dringend empfohlen, gleichzeitig die Funktion “Show graph 

data point“ zu aktivieren, da der Cursor=Mauspfeil (wechselt dann in ein Handsymbol) genau 

auf dem Messpunkt platziert werden muss, sonst erscheint „kein Messwert an diesem 

Datenpunkt vorhanden“, auch wenn die Cursorlinie den Datenpunkt schneidet. Dies ist 

notwendig, da bei mehreren dargestellten Parametern die Abtastpunkte auf einer vertikalen 

Linie liegen. Der Cursorwert wird links oben in der Farbe des jeweiligen Graphen angezeigt. 

Der Graph zwischen 2 Abtastwerten wird linear interpoliert. Die Bewegung des Mauszeigers 

horizontal und vertikal zum Bildrand markiert einen Zeitabschnitt zum Aufzoomen des 

Graphen. Drücken der linken Maustaste und der Tasten “Pfeil rechts bzw. links” bewirken ein 
Verschieben der Zeitachse zu früheren oder späteren Abtastwerten (äquivalent zur 

Bildlaufleiste am unteren Rand).  

Graph Data Points: siehe oben 

Analysis Values: siehe oben 

Graph Attributes: Für die nächste neue graphische Darstellung kann die voreingestellte 

Darstellungsweise oder die zuletzt gespeicherte aufgerufen werden. Elog speichert jede 

Änderung eines Darstellungsmerkmals zusammen mit der Graphik ab. 

 

Graph Annotation: Hier können mehrere graphische Darstellungen mit einer einheitlichen 

Anmerkung versehen werden (z.B. Kunde oder Messort)  

 

Retrieve Data From Logger 

Identische Funktion wie im Logger-Menu, siehe dort. 
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Open Data File 
Öffnet ein Fenster, wo vorhandene Dateien mit Messdaten zu sehen sind. Diese mussten zuvor vom 

Logger mit Logger > Retrieve Data... heruntergeladen worden sein.  

In der 1.Spalte werden die Messwerte fortlaufend nummeriert, die 2. und 3. Spalte zeigen Datum 

und Uhrzeit der Messungen. Die weiteren Spalten beinhalten die Messwerte der spezifizierten 

Parameter. Falls Minima und Maxima aufgezeichnet wurden, wird auch der Zeitpunkt ihres 

Auftretens sekundengenau dargestellt. 

Export Data File 
Die binären* .elog - Dateien können im * .csv- Format (Comma Separated Value) zu spreadsheet oder 

Datenbankprogrammen exportiert werden. (spreadsheet: z.B. Excel) 

Hinweise zum Export-Format im Anschluss dieses Kapitels, ab Seite 62 

Import CSV File 
Ein Import von *.csv-Dateien ist ebenfalls möglich. 

Die folgenden Menüpunkte sind erst sichtbar, wenn eine Messdatei geöffnet wurde. 

 

DATA FILE SUMMARY 
Liefert eine zusammenfassende Darstellung von Informationen zu den Messdaten, dem verwendeten 
Logger und dessen Setup. Hier werden die aufsummierten Werte für kWh, kVARh und kVAh 

angezeigt.  

Die Datei besteht aus drei Teilen:  

• Data Summary – liefert Start- und Stopp-Zeit der Messung, Dateiname und 

Summenwerte für jeden aufgezeichneten Kanal und Parameter. 

• Setup Summary – zeigt die wesentlichen Parameter des Setups.  

• Logger Summary – liefert Informationen zum benutzten Logger. Das Data File Summary 

ist in Microsoft Notepad geöffnet und kann editiert, gespeichert oder gedruckt werden. 
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ANALYZE A SELECTED DATA RANGE 

ELOG bietet eine Anzahl von Analysefunktionen, diese können auch immer mit der rechten 

Maustaste geöffnet werden. 

Klicke auf Analyze a Selected Data Range (Analysiere einen ausgewählten Datenbereich), zuvor muss 

eine Spalte oder ein Teilbereich einer Spalte mit der linken Maustaste markiert werden, oder in der 

markierten Spalte rechte Maustaste drücken, um die verfügbaren Optionen anzuzeigen.  

 

Beachte: Die Analysefunktion kann nur für einen Parameter aktiviert werden. 

Beispiel: Maximum, es werden die jeweils 5 größten Werte des markierten Bereichs 
-absteigend- angezeigt.  

 

 

 

Klicke OK zum Schließen des Fensters.  

 

1. Klicke File zum Öffnen von Windows Notepad™. 

Der analysierte Parameter, Aufnahmezeitraum sowie Analyseergebnis werden an Notepad™ 

übergeben. Dabei wird jede Analyse zu der schon geöffneten Notepad-Datei hinzugefügt, so 

dass eine Zusammenstellung aller Analyseergebnisse ermöglicht wird. 

 

Average ist der arithmetische Mittelwert 

aller markierten Messwerte. Load Factor 

ist das Verhältnis von Spitzenwert zu 

Mittelwert. Maximum und Minimum sind 
der größte und kleinste Wert mit Datum 

und Uhrzeit des Auftretens. Total ist die 

algebraische Summe aller Werte (nützlich 

zur Berechnung des Energieumsatzes 

kWh innerhalb einer definierten Zeit). 

 

 

2. Wähle Graph oder Daily Profile Graph (Tagesprofil) zur graphischen Darstellung der 
gewählten (markierten) Parameter.  Daily Profile Data Points zeigt das Tagesprofil in 

Listenform. 
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EXTRACT A RANGE OF DATA 

Erstellt einen definierbaren Ausschnitt, falls nicht alle Messdaten benötigt werden. 

Extract By Date: Öffnet ein Fenster, wo Start- und Stopp-Zeit der ursprünglichen Messreihe 

angezeigt werden und eine neue Start- und Stopp-Zeit eingegeben werden kann. 

Extract By Record Number: wie oben, nur bezogen auf die laufende Nummern der Messdaten 

CHECK DATA FOR ERRORS 

Zum Finden von Lücken oder Überlappungen im zeitlichen Ablauf oder von Zeitstempelfehlern. 

FILL MISSING RECORDS 

Entdeckt Lücken und füllt die Parameterwerte mit “0” 

 

 

 

 

FORMAT-HINWEISE FÜR DATA EXPORT IN TABELLEN (EXCEL)  
 

Auf Grund des amerikanischen Datenformates ist beim Export von abgespeicherten Daten des 

ELITEpro XC aus ELOG in ein deutsches Tabellenformat (z.B. EXCEL) eine Konvertierung notwendig. 

 

Hier ein Beispielablauf:  

 

Export in ELOG aufrufen: 
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Auswahl des abgespeicherten ELOG Files 

 
 

Benennung und Ablage des Files in ein .csv Format 

 
 

Nach Öffnen des .csv-Files mit auf deutsch installiertem EXCEL werden die Daten einer Zeile auf 

Grund des unbekannten Formates in einer Spalte übernommen.  
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Die Konvertierung in die deutsche Tabellenform wie folgt vornehmen: 

 

Die erste Spalte markieren 

Unter „Daten“ die Auswahl „Text in Spalten…“ auswählen 

 
 

Den darauf folgenden Assistenten mit „Weiter >“ bestätigen 

 
 

Änderung des Trennungszeichens von Tabstopp auf „Komma“ 
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Jetzt wichtig! „Weitere…“ anklicken 

 
 

Hier die Umkehrung des amerikanischen Formates durchführen: 

 

Dezimaltrennzeichen von Komma auf Punkt setzten, 

     1000er-Trennzeichen von Punkt auf Komma setzen 

Mit „OK“ bestätigen  

 
 

und mit „Fertig stellen“ Tabellenkonvertierung ausführen. 

 
 

Jetzt liegen die Daten in der richtigen Form zur Weiterverarbeitung des deutschen EXCEL vor. 
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ELOG Speed Buttons  

Die ELOG “hot buttons” erlauben eine schnelle Navigation zwischen häufig genutzten Funktionen . 

z.B. Kann zur Verbindungsherstellung zwischen PC und ELITEpro XC ™, der  button genutzt 

werden anstelle des Menu-Kommandos Logger > Communication > Direct Connection. Die button 

toolbar kann mit View > Toolbar ein- und ausgeblendet werden. 

  New: Erstellen einer neuen Datei  

 Open: Öffnen einer vorhandenen Datei 

 Save: Speichern 

 Cut: Ausschneiden 

 Copy: Kopieren 

 Paste: Einfügen 

 Print: Drucken des aktiven Fensters 

 Direct Connection: Direkte Verbindung von Logger und PC via USB Kabel 

 Network Connection: Stellt eine LAN-Verbndung her  

 Manual Dial: Manuelle Anwahl eines remote loggers (nur ELITEpro) 

 Choose from last used Logger List: Auswahl aus einer Logger-Liste 

 Disconnect: Verbindungstrennung 

 Cancel COMM OP: Abbruch der laufenden Kommunikations-Operation 

 Toggle Connection Window: Ein- und Ausblenden des Kommunikations-Statusfensters 

 Display Real Time Text Values: Anzeige von Echtzeitmesswerten 

 Retrieve Logger Data: Übertragen der Daten vom Logger 

 Setup PC: Schnellzugriff zum PC Setup 

 Create Graph: Erstellen eines Graphen aus einer geöffneten Datendatei 

 UnZoom Graph Zurückspringen auf Ausgangswert der Zeitachse 

 About: Öffnen des ELOG Manual (Englisch)
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ANHÄNGE 

ANHANG A – INSTALLATION VON FIRMWARE UPDATES  

FIRMWARE UPDATES 
Zum Überprüfen der Versionsnummer ihres ELITEpro XC: 

Starte ELOG™ und stelle Verbindung vom Logger zum PC mit Logger > Communication > Direct 
Connect her. 

Die Versionsnummer wird im Verbindungsfenster im ID-Feld angezeigt. 

 

 

DOWNLOAD UND INSTALLATION EINES FIRMWARE-UPDATES 

1. Wähle Tools > Update Logger Firmware. Das folgende Dialogfenster erscheint. 

 

 

 
 

2. Klicke den Browse button zur Lokalisierung der Update-Datei. 

3. Klicke Update. 

4. Der Fortschritt im Update-Prozess wird angezeigt. 
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ANHANG B – SELTENE MESSANORDNUNGEN 

3 Phasen DELTA mit “Wild” (Red) Leg 

 
3 Phasen DELTA mit “Wild” (Red) Leg 

Setup-Konfiguration: 
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2 ½ Element Meters 

 
2 ½ Element Meters 

Setup-Konfuguration: 

 
*Stromkanal 3 des ELITEpro XC wird mit L2 mit Pfeil zur Quelle verbunden. Beachte, dass Kanal 3 und 4 

parallel geschaltet sind. 

**Da die 2 ½ Element-Methode oft zur Messung in Hochspannungssystemen verwendet wird, ist ein PT ratio 

ungleich 1 typisch und muss entsprechend dem tatsächlich vorhandenen eingestellt werden..  

***Eingabe des Zangenwertes entsprechend des verwendeten Wandlers am ELITEpro XC.  Bei dieser 

Anwendung werden wahrscheinlich Hochspannungsstromwandler vorhanden sein. Es wird 

empfohlen, einen hochgenauen 5A Wandler von DENT Instruments an die Sekundärseite des 
Hochspannungsstromwandlers anzuschließen. Vorausgesetzt, dieser hat sekundärseitig einen 5A-

Ausgang, kann beim Wandler-Wert im Setup der Wert der Primärseite eingetragen werden. 
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ANHANG C – FEHLERBEHEBUNG BEI DER ELITEPRO XC TREIBER 
INSTALLATION 
Wenn Sie den ELITEpro XC mit dem PC per USB –Kabel verbunden haben und die Treiberinstallation 

fehlgeschlagen ist, bitte folgende Schritte zur Lösung des Problems ausführen.  

1. Im Startmenu des PC Computer (unter XP Arbeitsplatz) mit rechter Maustaste anklicken, 

dann Eigenschaften – Gerätemanager (XP: - Karteikarte Hardware- Gerätemanager) 

auswählen.  

 

  
Windows Vista und 7/8 Windows XP 

 

 
Windows Vista und  7/8 
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Windows XP 

 

3. ELITEpro XC im Geräte Manager-Fenster suchen: 

 

 

 

4. Rechts-Klick auf ELITEpro XC und Update Driver… wählen 
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5. Im Hardware Update Wizard, wähle Install from a list or specific location (Advanced) und klicke 

Next. 

 

 
 

6. Im nächsten Fenster wähle Search for the best driver in these locations ( Suche nach dem besten 

Treiber) und Include this location in the search (Unterordner in Suche einbeziehen). Klicke Browse 

und rufe den ELITEpro XC Treiber-Ordner im ELOG Verzeichnis. 

 

 
 

7. Klicke Next> und der ELITEpro XC Treiber wird installiert. Falls ein Fenster mit einer Microsoft-

Warnung erscheint, klicke Continue um fortzusetzen. 

8. Verbindung zum ELITEpro XC trennen und wieder herstellen. ELOG sollte automatisch starten und 

die Verbindung zum Logger herstellen. 
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ANHANG D – AUTOPOLL: AUTOMATISCHE KOMMUNIKATION 
ZWISCHEN PC UND LOGGER 
 

AutoPoll wird zusammen mit der ELOG-Software installiert. AutoPoll dient der automatischen 

Datenübertragung vom Logger zum PC mittels Abruf durch den PC.   

AutoPoll (Abkürzung für Automatic Polling) ist eine eigenständige Windows-Anwendung, die aus 
ELOG mit Logger > Communication > AutoPoll gestartet werden kann. AutoPoll arbeitet in 

Verbindung mit einer Logger List, in welcher die abzufragenden Logger aufgeführt sind, deren 

Verbindungs-Informationen, Zeittafeln sowie andere auszuführende Aufgaben. 

AutoPoll hat nur begrenzte Möglichkeiten der Einflussnahme durch den Nutzer und ist in erster Linie 

als automatischer “Dialer” (Wählapparat) gedacht. Nach dem Start von AutoPoll werden Sie zunächst 

aufgefordert, eine Logger-Liste auszuwählen, die den Logger, auf den Sie zugreifen möchten, 

beinhaltet. Es kann nur eine Logger-Liste aktiv sein. Nach Auswahl der gewünschten Liste erscheint 

ein Bildschirm ähnlich diesem: 

 

Ab jetzt läuft AutoPoll im Hintergrund und der PC kann für andere Aufgaben genutzt werden.  

 

File (Datei-) Menu  

Es werden die bekannten Windows-Kommandos genutzt. 

New (Neu): Öffnet eine neue Logger-Liste: Gruppen von 

Loggern, die AutoPoll nutzen. Logger List Dateien haben eine 

.lst Erweiterung. 

Open(Öffnen): Öffnet eine vorhandene Logger Liste 

Save(Speichern) (Ctrl+S) and Save As: Speichert eine 

geöffnete Logger Liste am alten Platz (Save) oder mit neuem 

Namen und/oder Pfad (Save As).  

Print(Drucken): Auswahl der zu druckenden Seiten. 

Print Preview:  Druckvorschau 

Print Setup: Auswahl des Druckers, des Druckbildes usw. 

Exit: Schließt das Programm.  
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Edit Menu 

Add Logger: Fügt einen neuen Logger der Liste hinzu 

Remove Logger: Entfernt einen Logger aus der Liste 

Cut, Copy, Paste: Ausschneiden, Kopieren, Einfügen 

(Windows-Kommandos). 

 

 

View Menu 

Schaltet Toolbar (Werkzeugleiste) und Status Bar (Status-Leiste) ein und 

aus. Die Statusleiste am unteren Bildschirmrand zeigt den aktuellen Abruf-

Status an. 

Die “Aktive Call List” ist die Logger Liste, von der die Abrufe gesteuert 

werden. Sie kann geschlossen und verborgen werden, ist aber in AutoPoll 

solange aktiviert, bis eine neue Logger Liste geöffnet wird, die die 

vorhandene ersetzt. 

 

Communications Menu 

Delay Today's Calls: Dient zur zeitweiligen Änderung der 

Abrufzeiten an einem Tag bis zu 24h.  

Klicke auf die  buttons um die Dauer der Verzögerung zu 
wählen, dann klicke OK. Nach Ablauf der Verzögerungszeit 

werden alle Daten, die innerhalb dieses Zeitraumes hätten 

abgerufen werden sollen, sofort übertragen. 

Cancel Today's Calls: Löscht alle Abrufe für diesen Tag, es 

werden keine Abrufe später nachgeholt. 

Repeat Today's Calls: Wiederholung der Abrufe, 

hilfreich, falls bei der Datenübertragung ein Fehler 

aufgetreten ist. 

Terminate Current Call: Abbruch aller Aufrufe 

 

 

 

 

 

Beachte:  Jegliche Aktion einschließlich Datenübertragung 

kann auch mit dem (Cancel COMM Op) hot button  

beendet werden. 
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Tools Menu  

Das PC Setup dient der Einstellung diverser Parameter wie Schnittstellenauswahl, Baud-Raten u.a.   

 

Es erscheint folgender Bildschirm:  

 

Auswahl des voreingestellten Pfades, wo die 

Logger Listen gespeichert sind, der COM-

Schnittstelle und der Baud-Rate. 

 

 

 

 

 

 

 

 

 

 

 

Log File (Protokoll-Datei) 

 

 

 

View AutoPoll Log: AutoPoll erzeugt eine Text-Datei mit der Zusammenfassung aller 

Abrufe des/der Logger(s).    

 

Beispiel: 
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Am Ende jedes Abrufes wird eine gestrichelte Linie eingefügt. 

Diese Datei zeigt den Status jedes Abrufes und jedes versuchten Abrufes des/der Logger in 

der Logger Liste, eingeschlossen der Änderung der Logger-Zeiteinstellung, falls das Set Logger 

Clock flag in der Logger Liste aktiviert wurde. Am Ende jedes Aufzeichnungszyklusses wird 
eine Zusammenfassung der versuchten und erfolglosen Abrufe gezeigt. Falls die Software 

dreimal einen Abruf versucht hat und erst der dritte erfolgreich war, wird in der 

Zusammenfassung nur 1 Call Attempted - 0 Calls Failed (1 Abruf-Versuch -0 Fehler) angezeigt. 

Die erzeugte Datei erhält den Namen autopoll.log und wird automatisch in den Ordner 

gespeichert, der das ELOG-Programm enthält (typisch C:\Program files\DENT\ELOG). Der 

Speicherort für die Log-Datei kann nicht separat vom ELOG-Programm gewählt werden. 

Nach einem weiteren Aufnahmezyklus wird die autopoll.log-Datei automatisch ergänzt. d. h. 

die neuen Protokolldaten werden an die vorhandenen angehangen. Die Datei kann maximal 

1 Megabyte groß werden. Wird diese Größe überschritten, erzeugt AutoPoll eine .bak 

Sicherungsdatei und startet eine neue .log Datei. Eine eventuell schon vorhandene 
Autopoll.bak Datei würde gelöscht und durch die neue ersetzt. 

Autopoll.log ist ein Text-Dokument (.txt), welches mit einem geeigneten Editor-Programmm 

(z.B. Notepad) gelesen und ausgedruckt werden kann. 

Clear AutoPoll Log: Löscht die aktuelle LOG-Datei, diese kann dann nicht wieder hergestellt 

werden. 

- DENT Instruments -  

 

AutoPoll Event Log File 

 

Connecting to logger ELITE on 04/10/12 at 10:54:31 

Direct connection to logger ELITE completed 

Setting clock from 10:54:36 04/10/12 to 10:54:38 04/10/12 for logger ELITE 

Task complete for call to logger ELITE 

Downloading data for logger ELITE 

Download of data from logger ELITE completed. Appended to file ELITE-

01.elog 

All session calls completed - 1 Calls Attempted - 0 Calls Failed 

 

---------------------------------------- 

 

Connecting to logger ELITE on 04/10/12 at 11:08:01 

Direct connection to logger ELITE completed 

Setting clock from 11:08:07 04/10/12 to 11:08:08 04/10/12 for logger ELITE 

Task complete for call to logger ELITE 

Downloading data for logger ELITE 

Download of data from logger ELITE completed. Appended to file ELITE-

01.elog 

All session calls completed - 2 Calls Attempted - 0 Calls Failed 

 

---------------------------------------- 
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Logger Lists 

Die Logger-Liste dient der Verwaltung der Logger, die manuell oder mit AutoPoll abgefragt werden 

sollen. Sie beinhaltet Verbindungsdaten (z.B. falls vorhanden, Telefonnummer des Modems des 

Loggers) und den Zeitplan zum Datenabruf. Die Anzahl der Logger in der Liste ist nicht begrenzt, es 

kann auch nur ein einziger sein.  

Mit dem Kommando File > Open (or New) > Logger List File wird die Liste geöffnet, Open zeigt den 

Ordner, aus dem eine vorhandene Liste geöffnet und editiert werden kann, New öffnet eine neue, 

leere Liste wie dargestellt: 

 

Serial Number ist die 9-stellige Seriennummer. Wenn die hier eingegebene Nummer nicht mit 

der tatsächlichen übereinstimmt, werden die Daten übertragen und in der LOG-Datei ein 

Fehlerhinweis vermerkt. 

Description (optional) Beschreibung, z.B. Einsatzort 

Setup Einstellen der Verbindungs-Parameter. 

Add Logger fügt eine weitere Zeile zur Liste hinzu. 

Remove Logger entfernt einen Logger aus der Liste. Dazu mit der linken Maustaste die 

betreffende Loggernummer markieren und dann Remove Logger klicken. 

 

Nach Klicken auf Setup erscheint folgender Bildschirm: 



 

 

PK elektronik Poppe GmbH Seite  

www.pk-elektronik.de 79 vertrieb@pk-elektronik.de 

 

 

 

Karteikarte Connection (Verbindung) 
Voreingestellt (default) ist Network (LAN). Es müssen IP-Adresse und Port-Nummer eingegeben 

werden.  

Falls der Logger nicht mit einem LAN verbunden werden soll, klicke Type: Direkt (seriell) oder 

Telefon-Modem. Für die serielle Verbindung baud rate (default ist 57600) und PC COM port (default 

ist COM 1) einstellen. Für Telefon-Verbindung baud rate (default ist 14400 baud) und Telefon-
Nummer des Logger-Modems eingeben. 

Data File Path: (optional) Informiert über den Speicherort für die abgerufenen Daten. AutoPoll 

speichert in den im ELOG-Hauptmenü unter Tools > PC Setup festgelegten Ordner. 

 
Karteikarte AutoPoll  
Hier wird der zeitliche Ablauf der automatischen Datenabrufe definiert. 

Die Voreinstellung zeigt einen einmaligen Abruf (Single Call) am 1. Januar um 0:00 Uhr. Es werden 
nur die Daten übertragen, die seit dem letzten Abruf hinzugekommen sind (Append New Data). 

 

 

 
 
 

 

Hinweis: Zum Anhängen der Daten schaut AutoPoll in den in Tools > PC Setup für diesen Logger 
spezifizierten Ordner. Falls dort(noch) keine Daten-Datei existiert und Append New Data aktiviert 

wurde, überträgt AutoPoll den gesamten Speicher des Loggers. 
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Logger Tasks (Aufgaben) 
 

Set Logger Clock—Falls aktiviert, wird nach der vollständigen Übertragung der Daten die Logger-

Zeit auf die PC-Zeit eingestellt (synchronisiert). 

Download Data—Es gibt zwei Möglichkeiten zur Datenübertragung: „Download All Data“ (Alle 

Daten übertragen) oder Append New Data (Neue Daten anhängen) „Append New Data“ wird für 

fortlaufende Messprojekte benötigt, es werden nur die Daten, die seit der letzten Übertragung 
gespeichert wurden abgerufen und dann an die vorhandene Daten-Datei angehangen. 

 

Create .csv File—Falls aktiviert, wird zusätzlich eine .csv-Datei erzeugt, diese kann dann z.B. in 

Excel weiterverarbeitet werden. Die .elog-Datei bleibt davon unberührt.  

Call Interval (Abruf-Intervall) 
Es stehen 5 Abruf-Varianten zur Auswahl, es kann jedoch nur ein Zeitintervall festgelegt werden. 

Zur Auswahl stehen: 

Immediate Call—Sofort-Abruf: sollte zur Überprüfung des korrekten Anschlusses des Loggers 

und der Funktionstüchtigkeit der Datenübertragung genutzt werden.  

Single Call—Einmalige Datenübertragung: es müssen Datum und Uhrzeit festgelegt werden. 

Multiple Calls—Vielfach-Abrufe: Der Logger wird mehrmals täglich abgerufen.“ First Call Time“ 

legt den Zeitpunkt der ersten Übertragung fest, das Intervall für die nachfolgenden Abrufe wird 

mit „Then Call Every“ definiert. Der erste Abruf erfolgt am ersten Tag nach Abspeicherung der 

Loggerliste. 

Daily Call—Täglicher Abruf: Daten werden täglich zur gleichen Zeit übertragen, in dem „Time To 

Call “-Kasten Uhrzeit festlegen 

Weekly Call—Wöchentlicher Abruf: Abruf der Daten an einem oder mehreren Tagen einer 

Woche, in dem “Weekly Times To Call “-Menübereich Tag und Uhrzeit wählen. Es kann nur ein 

Abruf pro Tag stattfinden, dieser kann aber an den gewählten Tagen zu verschiedenen 

Zeitpunkten erfolgen. 

 

 

 

 

 

Beachte: Alle Zeitangaben müssen mit der Maus ausgewählt 

werden, klicke die  Pfeile, um den gewünschten Wert 

einzustellen. 
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ANHANG E – BERECHNUNGSFORMELN 
 

Die folgenden Informationen zeigen, nach welchen Formeln die Parameter in Kanal 5 und 6 
berechnet werden. 

 

Sternschaltung 
 

Messwert Formel Beschreibung/Anmerkungen 

Amps (System) 
L1 + L2 + L3 

3 

Mittelwert aus L1, L2 und L3 

Strommesswerten 

Volts (System ) 

Summe der Phasenspannungen gegen 

N 
3 

Mittelwert der 

Phasenspannungen gegen N. 

kW (System) L1 kW + L2 kW + L3 kW Summe der Phasenleistungen. 

kWh (System) 
L1 kW + L2 kW + L3 kW 

# of samples in an hour 

Die Berechnung des 

Energieumsatzes erfolgt durch 

Integration der einzelnen 

(vorzeichenbehafteten) 
Abtastwerte der Leistung in 

jeder Phase. Eine einfache 

Mttelwertbildung wäre 

fehlerhaft, wenn Lasten Energie 

verbrauchen und erzeugen. 

VAR (System) L1 kVAR + L2 kVAR + L3 kVAR 
 

 

VARh (System) 
L1 kVAR + L2 kVAR + L3 kVAR 

# of samples in an hour 
Siehe kWh. 

VA (System) L1 kVA + L2 kVA + L3 kVA  

VAh (System) 
L1 kVA + L2 kVA + L3 kVA 

# of samples in an hour 
Siehe kWh. 

Apparent PF System 
kW System 

kVA System 
 

Displacement PF 

System 

kW System 

(SQRT(kW System * kW System + 

kVAR System * kVAR System)) 
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Dreieck: L1-L2 and L3-L2 

Gilt für Aron-Schaltung. Bei Messung aller drei Phasen gelten die Gleichungen wie bei Sternschaltung. 

 

Messung Berechnungsformel Bemerkung 

Amps (System) 
L1 + L3 

2 
Mittelwert von L1 und L3  

System Volts (Phase to 

Phase with DELTA 

configured meter) 

(L1-L2) + (L3-L2) 

2 

Mittelwert von L1- L2 and L3 – 

L2 Phase-Phase 

kW (System) L1 kW + L3 kW kW-Summe L1, L3 

kWh (System) 
L1kW +L3kW 

# of samples in an hour 

Siehe kWh (System) 

Sternschaltung 

kVAR (System) L1 kVAR + L3 kVAR 
 

 

kVARh (System) 
L1 kVAR + L3 kVAR 

# of samples in an hour 

Siehe kWh (System) 

Sternschaltung 

kVA (System) 
SQRT[(System kW *System kW) + 

(System kVAR * System kVAR)] 
 

kVAh (System) 

Akkumulation der Abtastwerte: 

SQRT[(System kW *System kW) + 

(System kVARs * System kVARs)]  

Kann nur aus den Basis-

Abtastwerten kW and kVAR 

berechnet werden 

Apparent PF System  
APF kann nicht berechnet 
werden 

Displacement PF System 

kW System 

(SQRT(kW System * kW System + 
kVAR System * kVAR System)) 

Berechnung von kVA (System ) 

siehe oben) 
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ANHANG F – DETAILLIERTE SCHNITTSTELLENBESCHREIBUNG 
In diesem Abschnitt werden die verfügbaren Verbindungsmöglichkeiten und deren Setups in 

weiteren Detail beschrieben, welche USB, Ethernet, WiFi, ELITEpro XC Geräte mit Bluetooth wireless 
technology und Funk- Modem beinhalten. 

 

USB -Anschluss 
 

 
  

1. USB –Kabel mit PC Und Logger verbinden. In Verteilungen/Schaltanlagen einen 

Mindestabstand von 5 cm zu stromführenden Leitungen einhalten. 

2. ELOG 13 starten. 

3. Der ELITEpro XC sollte automatisch mit dem PC verbunden werden. Falls nicht das 

Friendly Ports drop down menu nutzen. Siehe auch Communicate with the ELITEpro XC in 

Abschnitt 1. 

Ethernet (LAN-) Verbindung 
 

Eine LAN-Verbindung muss zunächst per USB-Verbindung konfiguriert werden. Der Nutzer muss 
Netzwerkdetails kennen und ggf. die Unterstützung des IT-Administrators anfordern. 

 

  

USB Port 
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Beachte: Jeder ELITEpro XC , der mit einem Netzwerk verbunden ist erfordert eine eigene 

Netzwerkadresse, außer wenn das Netzwerk DHCP (Dynamic Host Configuration Protocol) 

erlaubt und der ELITEpro XC mit automatically request an address (Automatische Adress-

Anforderung) konfiguriert ist. 

 

 
 

1. USB-Verbindung herstellen, siehe oben. 

2. ELOG starten. 

3. Der ELITEpro XC sollte automatisch mit dem PC verbunden werden. Falls nicht das 

Friendly Ports drop down menu nutzen. Siehe auch Communicate with the ELITEpro XC in 

Abschnitt 1. 

4. Nachdem der ELITEpro XC die Verbindung mit dem PC hergestellt hat, konfiguriere das 

Logger Network Setup. 

a. Wähle Logger > Communication > Logger Network Setup. 
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b. Um eine eigene Netzwerkadresse für den ELITEpro XC zu vergeben, muss  IP 
Address, Subnet Mask, Gateway Address, und Local Port Number eingegeben 

werden, dann wähle Update Logger. Wiederhole die Prozedur für jeden 

einzelnen Logger. 

Wenn das Netzwerk DHCP erlaubt ist ein individuelles Logger-Setup nicht 
erforderlich. Wähle Use DHCP, dann Local Port Number eingeben und Update 
Logger klicken. 

 

 

Es erscheint dann folgende Meldung:  

 
 

OK drücken und Netzversorgung für den Logger sicherstellen. 

c.  USB - Kabel abziehen. 
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5. Der ELITEpro XC sollte automatisch mit dem PC verbunden werden. Falls nicht das 

Friendly Ports drop down menu nutzen. Siehe auch Communicate with the ELITEpro XC in 

Abschnitt. 

6. Gleichzeitig ist nur ein Verbindungstyp erlaubt. Mit Logger > Communication > Terminate 

Connection oder mit  Disconnect speed button die USB-Verbindung abbrechen. 

7. Um via LAN zu verbinden wähle Logger > Communication > Network Connect oder 

verwende den Network Connection speed button. 

 

 
 

8. Falls im Network Connect window ihre Network IP Adresse und Port Number nicht 

automatisch zu sehen sind, dann diese eingeben und mit OK fortfahren. 

 

Beachte: Wenn Sie ihre Network IP Adresse oder Port Number nicht kennen, den 

Scan button im Network Connect Fenster drücken. ELOG scannt die verfügbaren 

Verbindungsstellen und zeigt sie in der Logger Selection dialog box an. Nutze zur 
Bestimmung der Verbindungsstelle die Serial # und MAC ID; die Serial # beinhaltet 

die Seriennummer des Loggers und die MAC ID ist ebenso kennzeichnend für ihren 

Logger. Wähle die zutreffenden Optionen, klicke OK und dann nochmals OK im 

Network Connect Fenster um fortzufahren und die LAN-Verbindung herzustellen.
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WiFi Verbindung 
 

Eine WiFi Verbindung hat Reichweiten von ca. 10-100m, abhängig von der Installationsumgebung. 

Metallische Räume können die Reichweite reduzieren. 

  

Eine WiFi-Verbindung muss zunächst per USB-Verbindung konfiguriert werden. Der Nutzer muss 

Gerätedetails kennen und ggf. die Unterstützung des IT-Administrators anfordern.  

 

 
 
Eine WiFi –Verbindung kann auf wie folgt hergestellt werden: 

 

1. Verbindung des firmeneigenen WiFi Access Point (AP) mit einer festen IP Adresse. 

2. Verbindung des firmeneigenen Access Point (AP) mit einer vom AP bereitgestellten 

IP-Adresse. 

3. Direkte Verbindung des ELITEpro XC; der ELITEpro XC ist selbst AP. 

 

Die beiden zuerst genannten Arten setzten voraus, dass der WiFi Access Point Verbindung zu ihrem 

LAN hat. Möglicherweise müssen Sie mit ihrer IT-Abteilung IP-Adresse und Passwort abstimmen. 

 
Punkt 3 erfordert einen PC, ein Tablet oder Smartphone mit Verbindungsmöglichkeit zu einem AP 

und einen Internetzugang mittels Internet Explorer, Safari, Firefox oder Chrome. 
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Option 1 – Verbindung zum AP mit fester IP-Adresse 

 

1. Den ELITEpro XC mit USB-Kabel an den PC anschließen (USB Symbol: ). Bei Anschluss in 

einer/m Verteilung /Schaltschrank einen Mindestabstand von 5 cm zu stromführenden 

Leitungen einhalten. 

2. ELOG starten. 

3. Im ELOG Menü Logger > Communication > Logger WiFi Setup auswählen. Es erscheint 

folgendes Dialog-Fenster:  

 

 

 

Hinweis: ELITEpro XC Logger, die mit dem WiFi package ausgestattet sind, haben 

eine interne Antenne. Optional ist eine externe Antenne verfügbar. Die Auswahl 

erfolgt mit aktivieren (Haken setzen) ”Use External Antenna“. 

 

4. DHCP nicht aktivieren (kein Häkchen setzen in „USE DHCP“). 

5. Eingabe von SSID, WiFi Password und fixer IP Address. Möglicherweise erhalten Sie diese 

Information von ihrer IT-Abteilung. Gleiches gilt für die Schritte 6, 7 und 8. 

Hinweis: Zur Eingabe oder Änderung des WiFi Passwords wähle Change Password. 

ELOG 13 zeigt das WiFi Password Dialog-Fenster. Im Enter New Password-Feld 

Passwort eingeben und mit „OK“ bestätigen. Mit Hide your typing (Passwort 

verbergen) auswählen, ob das Passwort bei der Eingabe sichtbar sein soll oder nicht. 
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6. TCP Port eingeben, welches ELOG für die Verbindung verwenden soll.  

7. Subnet Mask eingeben.  

8.  Gateway Address eingeben.  

9. Nochmals alle Eingaben überprüfen, dann Update & Restart Logger klicken. 

10. ELOG aktualisiert die WiFi Einstellungen und fordert auf OK zu klicken, um den ELITEpro XC 
zurückzusetzen (reset). 

11. Wenn die blaue COMM LED am ELITEpro XC nicht mehr blinkt, in ELOG Logger > 

Communication > Logger Properties (Logger Eigenschaften) auswählen und die Eintragungen 

überprüfen. 

12. Um eine WiFi-Verbindung herzustellen den ELITEpro XC zunächst von der USB-Schnittstelle 

mit Logger > Connection > Terminate Connection (Abbruch der Verbindung) oder mit der 

 Disconnect Schaltfläche trennen. 

13. Dann mit Logger > Communication > Network Connection oder mit der  Network 

Connect Schaltfläche die WiFi-Verbindung herstellen.  

14. Im Network Connect Dialog-Fenster die IP address und die Port Number des ELITEpro XC 
eingeben und mit OK bestätigen. 

15. Den Verbindungsaufbau abwarten, wenn diese hergestellt ist können Details im Connection 

Window angezeigt und die Nutzung des Loggers fortgesetzt werden. 

 

Option 2 – Verbindung zum AP ohne feste IP-Adresse 

 

1. Den ELITEpro XC mit USB-Kabel an den PC anschließen (USB Symbol: ). Bei Anschluss in 

einer/m Verteilung /Schaltschrank einen Mindestabstand von 5 cm zu stromführenden 

Leitungen einhalten. 

2. ELOG starten. 

3. Im ELOG Menü Logger > Communication > Logger WiFi Setup auswählen. Es erscheint 

folgendes Dialog-Fenster: 
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Hinweis: ELITEpro XC Logger, die mit dem WiFi package ausgestattet sind, haben 

eine interne Antenne. Optional ist eine externe Antenne verfügbar. Die Auswahl 

erfolgt mit aktivieren (Haken setzen) „Use External Antenna“. 

4. DHCP auswählen. 

5. SSID des AP eingeben. 

6. WiFi password des AP eingeben. 

Hinweis: Zur Eingabe oder Änderung des WiFi Passwords wähle Change Password. 

ELOG zeigt das WiFi Password Dialog-Fenster. Im Enter New Password Feld Passwort 

eingeben und mit „OK“ bestätigen. Mit Hide your typing (Passwort verbergen) 

auswählen, ob das Passwort bei der Eingabe sichtbar sein soll oder nicht. 

7. Nochmals alle Eingaben überprüfen, dann Update & Restart Logger klicken. 

8. ELOG aktualisiert die WiFi Einstellungen und fordert auf OK zu klicken, um den ELITEpro XC 
zurückzusetzen (reset). 

9. Wenn die blaue COMM LED am ELITEpro XC nicht mehr blinkt, in ELOG Logger > 
Communication > Logger Properties (Logger Eigenschaften) auswählen und die Eintragungen 

überprüfen. 

10. Wenn der AP die IP Adresse für den ELITEpro XC zugewiesen hat, diese notieren, da sie im 

Weiteren noch benötigt wird.  

11. Um eine WiFi-Verbindung herzustellen den ELITEpro XC zunächst von der USB-Schnittstelle 

mit Logger > Connection > Terminate Connection (Abbruch der Verbindung) oder mit der 

 Disconnect Schaltfläche trennen. 

12. Die IP Adresse des ELITEpro XC wie in Schritt 10 notiert eingeben. 

13. Im Network Connect Dialog-Fenster die feste IP Adresse und die Port Number des 

ELITEpro XC eingeben und mit OK bestätigen. 

14. Den Verbindungsaufbau abwarten, wenn diese hergestellt ist können Details im Connection 

Window angezeigt und die Nutzung des Loggers fortgesetzt werden. 
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Option 3 – Verbindung herstellen mit dem ELITEpro XC als AP (Access Point) 

 

 
 

 

1. Den ELITEpro XC mit USB-Kabel an den PC anschließen (USB Symbol: ). Bei Anschluss in 

einer/m Verteilung /Schaltschrank einen Mindestabstand von 5 cm zu stromführenden 

Leitungen einhalten. 

2. ELOG starten. 

3. Im ELOG Menü Logger > Communication > Logger WiFi Setup auswählen. Es erscheint 

folgendes Dialog-Fenster: 

 

 

 

Hinweis: ELITEpro XC Logger, die mit dem WiFi package ausgestattet sind, haben 
eine interne Antenne. Optional ist eine externe Antenne verfügbar. Die Auswahl 

erfolgt mit aktivieren (Haken setzen) „Use External Antenna“. 
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4. Access Point Mode aktivieren (Häkchen setzen). 

5. Auswahl von Change Password und Eingabe eines web page password , um eine Verbindung 

mit dem ELITEpro XC web server herstellen zu können. 

6. Update & Restart Logger klicken. 

7. ELOG aktualisiert die WiFi Einstellungen und fordert auf OK zu klicken, um den ELITEpro XC 
zurückzusetzen (reset ). 

8. Wenn die blaue COMM LED am ELITEpro XC nicht mehr blinkt, in ELOG Logger > 

Communication > Logger Properties (Logger Eigenschaften) auswählen und die Eintragungen 

überprüfen. 

9. SSID und IP address des ELITEpro XC notieren. 

10. Danach das Wireless Network Connection Dialog-Fenster öffnen, möglicherweise muss 

Refresh geklickt werden. Den AP mit der SSID des ELITEpro XC auswählen und Connect 
klicken. Sicherstellen, dass Windows die Verbindung herstellt. 

11. Der Zugriff auf den ELITEpro XC kann dann auf zwei Wegen erfolgen: 

 

1. Verwendung von ELOG zur Verbindung mit dem ELITEpro XC AP: 

a. Um eine WiFi-Verbindung herzustellen den ELITEpro XC zunächst von der USB-

Schnittstelle mit Logger > Connection > Terminate Connection (Abbruch der 

Verbindung) oder mit der  Disconnect Schaltfläche trennen. 

b. Dann mit Logger > Communication > Network Connection oder mit der  Network 
Connect Schaltfläche die WiFi-Verbindung herstellen. 

c. Im Network Connect Dialog-Fenster die IP Adresse und die Port Number des 
ELITEpro XC eingeben und mit OK bestätigen. 

d. Den Verbindungsaufbau abwarten, wenn diese hergestellt ist können Details im 

Connection Window angezeigt und die Nutzung des Loggers fortgesetzt werden. 

 

Verwendung eines Web-Browsers zur Verbindung mit dem ELITEpro XC AP  

Wenn der TCP Port auf 80 gesetzt ist, kann eine Verbindung zum ELITEpro XC mit Hilfe 

eines Web Browsers hergestellt werden. Hier sind die Interaktionsmöglichkeiten zur 

Kommunikation mit dem Logger begrenzt, sinnvoll ist die Überprüfung der 

Funktionsfähigkeit der Verbindung. 

a. Web Browser öffnen. 

b. Im Adressfeld IP Adresse des ELITEpro XC eingeben, sie lautet: 192.168.1.1. 

c. Wenn die login Seite erscheint, das Web Page Password wie im WiFi Setup Dialog-

Fenster festgelegt eingeben (siehe Schritt 5 oben). 

d. Wenn die Verbindung hergestellt ist können Echtzeit-Werte angesehen werden, Daten 

als Excel CSV Datei heruntergeladen werden, die Aufzeichnung gestartet und gestoppt, 

der Speicher gelöscht und die Logger-Eigenschaften betrachtet werden. 
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Falls keine Verbindung hergestellt werden kann, bitte folgende Punkte überprüfen: 

1. Verbindung zum Logger via USB herstellen. In ELOG, unter Logger > Communication > Logger 
Properties die eingestellten Parameter, z.B. Adressen, prüfen. 

2. Überprüfen, ob die der Signalstärke (in Prozent oder dBm) ausreichend ist 

3. Sicherstellen, dass das WiFi Modul aktiviert ist, dies kann mit der “No TCP connection”-Anzeige 

erkannt werden. Die blaue Comm LED darf nicht blinken. 

4. Falls das Problem nicht gelöst werden kann, bitte DENT Instruments kontaktieren. 

 

Beachte: Der WiFi access point schaltet nach 5min Inaktivität ab. Abhängig vom genutzten 

Betriebssystem muss die Loggerverbindung mit close/reopen oder disconnect/reconnect 

wieder hergestellt werden. 

 

 

Bluetooth Wireless Technology Verbindung 
 

Der Logger und der PC müssen über eine entsprechende Option verfügen. Die Bluetooth wireless 

technology bietet eine Funkverbindung mit Reichweiten bis ca. 25m, abhängig von der 

Installationsumgebung. In abgeschirmten (metallischen) Räumen kann die Reichweite begrenzt sein.  

 

 
 
Die Verbindung muss zunächst per USB –Anschluss konfiguriert werden.  

 

Verbindung per Bluetooth wireless technology: Falls Sie noch nie ein Bluetooth-fähiges Gerät 

genutzt haben, sollten Sie sich in der Windows-Hilfe unter dem Stichwort “Bluetooth” allgemeine 

Informationen zur Installation von Bluetooth-Geräten anzeigen lassen. 
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Ihr PC muss mit Bluetooth wireless technology ausgestattet sein. Sonst muss zunächst ein Bluetooth 

wireless technology Modul (oder “dongle”) entsprechend der Herstelleranweisungen installiert und 

konfiguriert werden.  Dieses Modul muss das SPP (Serial Port Protocol) unterstützen. 
 

1. In der Systemsteuerung Bluetooth Geräte öffnen oder auf das Bluetooth-Symbol klicken: 

 

                                                 
 

2. Add a device (Hinzufügen) Button klicken, der Logger sollte mit seiner Seriennummer  

     angezeigt werden, Logger auswählen und Next klicken. In Windows 7/8 wird die die Eingabe  

     eines Verbindungscodes gefordert:  Enter the device’s pairing code  klicken 
 

3. Code eingeben, die Default - Einstellung ist: 1234.  

    Eine Meldung zur Betriebsbereitschaft sollte folgen. 

 
4. Jetzt erfolgt die Zuordnung der Bluetooth-Verbindung zu einem com-Port.  
     In ELOG auf den PC Setup speed button klicken. Windows kann 2 Ports zuweisen,  

     aber nur einer dient der Kommunikation, welcher, ist durch Probieren herauszufinden. 

 

 
 

5. Klicke im Direct Connect Port auf die erste Zeile “…Standard Serial over Bluetooth link…” der  
    Drop-Down Liste, danach “Save Changes”, und versuche die Kommunikation mit dem Direct  

    Serial or Bluetooth Connection speed button zu starten  

    oder klicke Logger > Communication > Connect via USB or Bluetooth.  

    Der Verbindungsaufbau kann bis zu 10 Sekunden dauern. Wenn der  erste Versuch fehlschlägt, 
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einen erneuten Versuch mit dem zweiten angezeigten Port starten. Falls notwendig, Versuch 

wiederholen, bis eine Verbindung hergestellt ist und die Port-Nummer bekannt ist. 

 

6.  ELOG PC Setup erneut öffnen und auf den Port Preferences button klicken.  
      Hier können die von ELOG nicht genutzten Ports aus der Auswahlliste entfernt werden.  

 

 
 

7.  OK und dann Save Changes im ELOG PC Setup klicken.  

     Die nicht benötigten Ports werden nicht mehr angezeigt. 

 

 

Falls keine Verbindung zustande kommt, bitte folgende Punkte überprüfen: 

1. In der Systemsteuerung unter Bluetooth-Geräte überprüfen, ob der Logger dort gelistet ist. 

Wenn nicht, die Installationsprozedur wie oben beschrieben wiederholen.  

2. Falls sich wieder kein Erfolg einstellt, überprüfen, dass die Stromversorgung des Loggers 
gesichert ist. 
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